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Qe About pharmacogenomics
experiments
B Introduction ......... ... 8
m  Workflow for OpenArray™ plate PGx experiments ........................ 9
WARNING! Read the Safety Data Sheets (SDSs) and follow the handling
instructions. Wear appropriate protective eyewear, clothing, and gloves. Safety
Data Sheets (SDSs) are available from thermofisher.com/support.
Introduction

Pharmacogenomics (PGx) is the study of genetic variation as it relates to drug
response. PGx studies involve testing samples for multiple variants in drug
metabolism enzyme (DME) and transporter genes. This guide describes procedures

for the sample-to-result PGx workflow solution using the QuantStudio™ 12K Flex
Real-Time PCR System.

Variant testing uses TagMan® SNP Genotyping Assay or TagMan® Copy Number
Assays targeting DME genes.

e The TagMan® Drug Metabolism Genotyping Assay collection has ~2,700 assays
that detect potentially causative polymorphisms in 221 drug metabolism enzyme
and associated transporter genes.

e TagMan® Copy Number Assays examine copy number variation (CNV) in DME
genes.

e There are 7 million predesigned TagMan® SNP Genotyping Assay and custom
TagMan® SNP Genotyping Assay available for other targets of interest.

8 Pharmacogenomics Experiments Application Guide
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Chapter 1 About pharmacogenomics experiments
Workflow for OpenArray™ plate PGx experiments

Workflow for OpenArray  plate PGx experiments

Chapter 3, Isolate DNA using the MagMAX™ DNA Multi-Sample Ultra Kit
v

[Optional] Appendix B, Preamplification of low-
concentration gDNA

v
Chapter 4, Prepare and run OpenArray PGx Chapter 6, Prepare, run, and analyze PGx
SNP genotyping experiments copy number experiments
v

Chapter 5, Analyze OpenArray” PGx SNP
genotyping experiments
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Chapter 7, Perform translation analysis in AlleleTyper™ Software

Note: See Appendix D for expected throughput rates of OpenArray  plates and
other system specifications.
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DME allele nomenclature

SNPs within drug metabolism genes are often identified by their standardized allele
name or star (*) allele nomenclature (Sim, 2010). Star alleles are gene-level haplotypes
(a set of DNA polymorphisms that are often inherited together on the same
chromosome). Often, these haplotypes have been associated with DME activity levels
(for example, functional, decreased function, or nonfunctional variants). The
combination of star allele haplotypes (that is, the diplotype) within a sample can be
used to predict its drug metabolizer phenotype (for example, ultrarapid, extensive,
intermediate, or poor). Genetic variants within a haplotype can include SNPs, InDels,
and CNVs. The allele nomenclature for a specific gene family is maintained and
standardized by an affiliated group of scientists that curate each site independently.
This nomenclature is complicated, because many alleles contain more than one
polymorphism (that is, they are haplotypes) and conversely, many polymorphisms
can be associated with several alleles.

The star allele nomenclature contains the DME gene name, such as CYP2D6, followed
by a numeric allele name, such as *3. A star allele conventionally contains at least one
causative variant (for example, a frameshift mutation). Variants are given reference
gene and/or cDNA coordinates, such as g.2549delA (full variant name: CYP2D6*3 g.
2549delA). The causative star allele variant can be associated with other nucleotide
variants in different haplotypes groups; such sub-alleles are denoted by letters
following the numeric allele identifier (for example, *3A). On the Cytochrome P450
(CYP) Allele Nomenclature web site, the defining, causative variant for a star allele is
often in bold font.

Note: *1 refers to the reference gene sequence, which produces an enzyme with
normal function. The reference gene sequence is not necessarily equivalent to the
reference genome assembly sequence, and it does not necessarily contain the major

10 Pharmacogenomics Experiments Application Guide
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allele for a given SNP (which can vary between populations, particularly for highly
polymorphic SNPs).

The defining variant for a given DME gene star allele may be the only variant needed
to identify that particular star allele. The defining allele is sometimes referred to as the
"tag SNP”. Common allele names are provided for many DME variants in the PGx
Common Markers file. See “The PGx Common Markers file” on page 26.

The DME Assay collection variants have been mapped for the genes having public
allele nomenclature sites. This allele nomenclature is searchable on the DME assay
product pages and in the downloadable TagMan® Drug Metabolism Genotyping
Assays Index file, available at www.thermofisher.com/pgx. The public allele
nomenclature websites provide information on DME gene star allele haplotypes, the
defining polymorphisms for these alleles, and links to the NCBI dbSNP website for
variants having an reference SNP (refSNP) identifier, or rs ID.

Table 2 DME allele nomenclature websites

Gene family Allele nomenclature website
CYP—Cytochrome P450 (CYP) genes www.cypalleles.ki.se
NAT1 and NAT2—Arylamine http://nat.mbg.duth.gr

N-Acetyltransferase genes

UGT—UDP Glucuronosyltransferase genes www.pharmacogenomics.pha.ulaval.ca/
ugt-alleles-nomenclature

Note: Other DME gene variants have allele nomenclature reported in the literature,
but no public nomenclature web site exists. For key variants, allele nomenclature is
found in the Very Important PGx (VIP) gene summary pages on the
Pharmacogenomics Knowledge Base web site www.pharmgkb.org.

Where possible, such allele nomenclature is provided for non-CYP, -NAT and -UGT
variants in the PGx Common Markers file. See “The PGx Common Markers file” on
page 26.

TaqMan® Drug Metabolism Genotyping Assays

The TagMan® Drug Metabolism Genotyping Assay, a collection of approximately
2,700 assays, detect potentially causative SNP, MNP or InDel polymorphisms in 221
drug metabolism enzyme (DME) and associated transporter genes. The DME assays
were designed using an optimized DME assay design algorithm that uses a high level
of bioinformatics to ensure a lack of underlying polymorphisms and high target
specificity (that is, gene family members and pseudogenes will not amplify). Assays
to more difficult targets underwent manual design. All DME Assays underwent
stringent wet-lab testing, including running with 180 unique DNA samples from four
different populations (African American, Caucasian, Chinese, and Japanese).

The TagMan® SNP Genotyping Assays were designed using a related, highly
validated SNP assay design algorithm. The SNP assays are functionally tested (that is,
for amplification and clustering capabilities) when first manufactured on 20 unrelated
gDNA samples from three populations (African American, Caucasian, and Japanese).
In addition, over 300 high value TagMan® DME and SNP assays were tested with 44
African American and Caucasian samples and synthetic templates representing each

Pharmacogenomics Experiments Application Guide 11
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genotype on OpenArray™ plates run on the QuantStudio™ 12K Flex Real-Time PCR
System, to ensure assay performance on this platform.

All TagMan® SNP Genotyping Assays, Drug Metabolism Genotyping Assays, and
Custom SNP Genotyping Assays contain sequence-specific forward and reverse
primers to amplify the polymorphic sequence of interest and two TagMan® MGB
probes with non-fluorescent quencher (NFQ):

* One probe labeled with VIC™ dye detects the Allele 1 sequence.
* One probe labeled with FAM™ dye detects the Allele 2 sequence.

TagMan® DME and SNP Genotyping Assay data is analyzed by cluster plot analysis:
FAM™ dye signal is plotted on the Y-axis, and VIC™ dye signal is plotted on the X-axis.
Samples homozygous for the FAM™- or VIC™-labeled alleles form clusters along the

™

Y- or X-axis, respectively, whereas heterozygous samples contain both FAM™ and

™

VIC™ dye signal and will cluster roughly along the diagonal position between the
homozygous clusters.

3,000
2750
o ® Homozygous for Allele 2
2,500
L
2,250
2,000
1,750
_ , Heterozygous
=
< 1,500
w
™
a
@ 1,250
S
1,000
750
500
200 Homozygous for Allele 1
No Template Control -
0 o0
-250

0 250 500 750 1,000 1.250 1,500 1750 2,000 2250
Allsle 1VIC ()

The reporter dye information for TagMan® Drug Metabolism and SNP Genotyping
Assays is represented in the assay context sequence, found at thermofisher.com and
provided in the Assay Information File (AIF) that you can download from the web at
www.lifetechnologies.com/OA-platefiles. The context sequence is the nucleotide
sequence surrounding the SNP site. It is provided in the (+) genome strand orientation
relative to the NCBI reference genome. The SNP alleles are included in brackets,
where the order of the alleles corresponds to the association with probe reporter dyes,
where [Allele 1=VIC" dye / Allele 2=FAM " dye].

Pharmacogenomics Experiments Application Guide
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Example: C__27102431_D0 assay

For C__27102431_DO assay targets the CYP2D6*4 g.1846G>A SNP, 153892097, and has
the following context sequence:

AGACCGTTGGGGCGAAAGGGGCGTC [C/T] TGGGGGTGGGAGATGCGGGTAAGGG

The VIC™ dye probe is associated with the C allele and the FAM"" dye probe is
associated with the T allele.

In this example, the SNP alleles (C/T) are the reverse complement of those given in the
star allele nomenclature: CYP2D6*4 g.1846G>A. This is because the context sequence
alleles are provided in the (+) reference genome strand orientation whereas the star
allele nucleotide changes are provided with respect to the CYP2D6 gene reference
sequence that maps to the (—) genome strand.

Several important DME gene variants are triallelic SNPs, wherein 3 bases occur at the
same genomic location. Triallelic SNP targets can be interrogated using a pair of
TagMan® assays. Each assay contains one probe for the major SNP allele, which is
labeled with the same reporter dye (VIC™ dye) in both assays, and one probe for one

™

of the minor alleles, which is labeled with the second reporter dye (FAM™ dye). To
generate accurate sample genotypes, the two assays must be run independently on
the same panel of samples, and the resulting allelic discrimination plots must be
analyzed in concert, comparing the genotype cluster positions from both assays to a
map of the true sample genotypes. See Table 15, on page “Analysis guidelines: SNP
genotyping assays for triallelic SNPs” on page 61 for analysis.

Table 3 TagMan® Drug Metabolism Genotyping Assays to triallelic SNPs

Gene rsID TaqMan® DME Assay Allele name ?jliané’ lifbl«:dl?”s]’
ABCB1 rs2032582 C_11711720C_30 |ABCB1 c.3095G>T C/A
C_11711720D_40 | ABCB1 c.3095G>A C/T
CYP2C9 rs7900194 C__25625804_10 |CYP2C9*8 c.449G>A A/G
C_25625804D_20 | CYP2C9*27 c.449G>T T/G
CYP2D6 rs5030865 C_30634117C_KO |CYP2D6*8 g.1758G>T A/C
C_30634117D_M0 |CYP2D6*14 g.1758G>A T/C
CYP1A1 rs41279188 C_30634152C_70 |CYP1A1*5g.2461C>A G/T
C_30634152D_80 | CYP1A1*9 g.2461C>T G/A
CYP2C8 rs72558195 C_72650009C_10 |CYP2C8*7 c.556C>T G/A
C_72650009D_20 |CYP2C8*8 c.556C>G G/C
13
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For certain DME targets, two SNPs are located adjacent to one another. This
complicates the SNP genotype analysis because for each assay, the probes will fail to
bind target sequences when the adjacent SNP is present. However, when the adjacent
SNPs are present in only 3 haplotypes, these SNPs can be interrogated similarly to
triallelic SNPs using two assays (see “TagMan® Drug Metabolism Genotyping Assay
for genotyping triallelic SNPs” on page 13).

Assay sets to two highly studied SNPs that have an adjacent, less frequently detected
SNPs, are available. In each case, the minor alleles of each SNP are not found together
in the same haplotype.

Table 4 DME Assays for genotyping adjacent SNPs

Gene SNP ID TagMan® DME assay Allele name
CYP2C19 rs4244285 C__25986767_70 CYP2C19*2 681G>A
rs6413438 C__30634128_10 CYP2C19*10 c.680C>T
CYP2C9 rs1057910 C__27104892_10 CYP2C9*3 c.1075A>C
rs56165452 C__30634131_20 CYP2C9*4 c. 1076T>C

CYP2C19*2,*10 adjacent SNP assays

Only 3 haplotypes have been observed for the CYP2C19 *2 and *10 SNPs
(www.cypalleles.ki.se/cyp2c19.htm): the rare *10 c.680T allele and the *2 c.681A do
not occur on the same chromosome. Thus, these adjacent SNPs can be analyzed
similarly as for triallelic SNPs. When the *2 assay is run on a sample containing a *10
allele, the probes will fail to detect the *10-containing allele; the converse is true when
the *10 assay is run on a sample containing a *2 allele. The context sequences for each
assay are shown below. After running paired assays for adjacent SNPs in separate
reactions on the same gDNA samples, examine the cluster plots in TagMan
Genotyper Software. Sample calls may need to be adjusted, and the results of each
assay compared to determine the true sample genotype, as detailed in “Analysis
guidelines: DME genotyping assays for genes in copy number variation regions” on
page 61.

CYP2C19*2 ¢.681G>A C__25986767_70

TTCCCACTATCATTGATTATTTCCc [A/G] GGAACCCATAACAAATTACTTARAAA

CYP2C19*10 ¢.680 C>T C__30634128_10

TTTCCCACTATCATTGATTATTTCC[C/T]gGGAACCCATAACAAATTACTTAAA
10 *2

TTTTCCCACTATCATTGATTATTTCC[C/T] [G/A]GGAACCCATAACAAATTACTTAAA

Pharmacogenomics Experiments Application Guide
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TagMan® Copy Number Assays

DME genes and
copy number
variation

Copy number variation must be assessed for DME genes known to exhibit copy
number variation (see “Pre-tested TagMan® Copy Number Assays for select DME
genes” on page 16). TagMan® Copy Number Assays are run simultaneously with a
TagMan® Copy Number Reference Assay in a duplex real-time polymerase chain
reaction (PCR). TagMan® Copy Number Assays detect the target gene or genomic
sequence of interest and the TagMan® Copy Number Reference Assay detects a
sequence known to exist in two copies in a diploid genome (for example, the human
RNase P H1 RNA gene). Relative quantitation (RQ) using the comparative C; (AACy)
method is used to determine the number of copies of the target sequence in each test
sample.

e TagMan® Copy Number Assays contain two primers and a FAM™ dye-labeled
MGB probe to detect the genomic DNA target sequence.

™

e TagMan® Copy Number Reference Assays contain two primers and a VIC

dye-labeled TAMRA™ probe to detect the genomic DNA reference sequence.
TagMan® Copy Number Assays are ordered as single tube assays (see “Single tube
products and formats” on page 27) and run on 96-well and 384-well plates on
Applied Biosystems™ Real-Time instruments, including the QuantStudio™ 12K Flex
Real-Time PCR System. There are currently no copy number assays developed for the
OpenArray™ plate.

Several DME genes exhibit copy number variation (CNV) or other structural
alterations due to recombination and gene conversions events between highly related
loci (He, 2011).

For DME gene variants that are associated with copy number variation, run both
DME genotyping assays and copy number assays to determine sample genotypes.

For DME assays that target a deleted or duplicated gene (for example, CYP2D6):
¢ samples that contain 0 copies of the gene will not amplify.

* samples with 1 or more gene copies that are homozygous for the SNP allele will
cluster together

* samples with more than 2 gene copies that are heterozygous may run within the
2-copy heterozygous cluster or between it and one of the homozygous clusters.

To discern the sample genotype, copy number quantitation of the gene target must be
done to determine which samples carry gene deletions or duplications. Additionally,
use of multiple copy number assays for a gene may be required for hybrid gene
analysis.

Note: The copy number assays are not SNP allele-specific and cannot be used to
determine which SNP allele is duplicated when a sample is heterozygous and has
three gene copies.

A protocol has been developed for determining allele-specific copy number of
CYP2De6 alleles by digital PCR. For more information, see CYP2D6 Allele-specific Copy
Number Analysis Quick Reference (Pub. No. MANO0011114).

Pharmacogenomics Experiments Application Guide 15
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Pre-tested TagMan® Copy Number Assays for select DME genes

Pre-tested TagMan®” Copy Number Assays are available for the DME genes in CNV
regions are shown in Table 5. These assays were run on 90 Coriell gDNA samples
from African American and Caucasian populations (the same panel used for DME
Assay validation).

Table 5 Pre-tested DME gene TagMan® Copy Number Assays for CNV and hybrid gene analysis

Gene symbol

Assay ID

Gene location

Major alleles detected

CYP2Dé6 Hs00010001_cn! Exon 9 CYP2D6 Deletion (*5); Duplications (for example, *1xN,
*2xN, *4x2, *9x2,*10x2, *17xN, *35x2)

CYP2Dé Hs04083572_cn Intron 2 CYP2Dé6 Deletion (*5); Duplications (for example, *1xN,
*2xN, *4x2, ¥*9x2,*10x2, *17xN, *35x2); 2D6/2D7 hybrid
alleles with 2D7 exon 9 sequences [for example, *36,
*83)

CYP2Dé Hs04502391 ¢n Intron 6 CYP2Dé Deletion (*5); Duplications (for example, *1xN,
*2xN, *4x2, ¥*9x2,*10x2, *17xN, *35x2); 2D6/2D7 hybrid
alleles with 2D7 exon 9 sequences [for example, *36,
*83)

CYP2A6 Hs07545273_cn Exon 1 CYP2Aé6 Deletion (*4); Duplication (*1x2)

CYP2A6 Hs07545274_cn Intron 1 CYP2Aé6 Deletion (*4); Duplication (*1x2)

CYP2A6 Hs04488984 cn Intron 2 CYP2A6 Deletion (*4); Duplication (*1x2); hybrid allele
with 2A7 exons 1-2 and 2A6 exons 3-9 (*12)

CYP2A6 Hs07545275_cn Intron 7 CYP2A6 Deletion (*4); Duplication (*1x2); hybrid allele
with 2A7 exons 1-2 and 2A6 exons 3-9 (*12)

CYP2A7 Hs07545276_cn Exon 1 CYP2A6 hybrid allele with 2A7 exons 1-2 and 2Aé6 exons
3-9 (*12)

CYP2A7 Hs04488016_cn Intron 2 CYP2A6 hybrid allele with 2A7 exons 1-2 and 2A6 exons
3-9 (*12)

CYP2A7 Hs07545277 cn Intron 7 No CYP2A6 alleles

CYP2E1 Hs00010003_cn Promoter CYP2E1 Duplication (*1x2)

GSTM1 Hs02575461 cn Exon 1 GSTM1 Deletion (*0); Duplication

GSTT1 Hs00010004_cn Intron 1 GSTT1 Deletion (*0)

SULT1A1 Hs03939601_cn Intron 2 SULT1A1 Deletion; Duplication

UGT2B17 Hs03185327 c¢n Exon 1 UGT2B17 in 150 kb Deletion (*2)

1 Assays in boldface type are those most frequently used for CNV and hybrid gene analysis.
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CYP2Dé copy The CYP2D6 gene is the most highly polymorphic and complex of the DME genes.
number variation Over 100 star allele groups have been identified by the Cytochrome P450
Nomenclature Committee (www.cypalleles.ki.se). At least 4 of these groups give rise

and

to alleles with substrate-dependent reduced enzyme activity, and more than 20 do not
CYP2_D6/ CYP2D7 encode functional enzymes.
hybrid alleles

The CYP2D6 alleles are composed of SNP and InDel variants, CNVs, and hybrid
alleles formed by recombination between CYP2D6 and highly related upstream
pseudogene, CYP2D7, sequences. Individuals may carry null alleles (*5) or extra
copies of CYP2D6 (*1, *2, *4, 9,10, *17, *35). Some CYP2D6 alleles contain sequences
derived from the highly homologous CYP2D7 pseudogene; for example, CYP2D6*36,
as well as *4N, *57, and *83, contains a gene conversion to CYP2D7 sequences in exon
9 associated with negligible CYP2D6 enzyme activity (Gaedigk, 2006).

Three different copy number assays to CYP2D6 sequences are available for
determining CYP2D6 gene copy number and to aid identification of some hybrid
alleles (see “Pre-tested TagMan® Copy Number Assays for select DME genes” on

page 16):

Table 6 Pre-tested TagMan® Copy Number Assays to CYP2Dé: detection of CYP2D7
exon 9 conversion alleles

Gene CYP2Dé full | CYP2D6*36 | CYP2D7 full
Gene Assay ID location length [2D6/2D7 length
alleles hybrid]t! alleles
CYP2D6 Hs00010001_cn Exon 9 Yes No No
Hs04083572_cn Intron 2 Yes Yes No
Hs04502391 cn Intron 6 Yes Yes No

1 QOther alleles with conversions to CYP2D7 sequences in exon 9: *4N, *57, *83

The primary copy number assay for CNV analysis is the exon 9 Hs00010001_cn assay,
which predominantly detects full-length CYP2D6 alleles and not hybrid alleles
containing the exon 9 conversion to CYP2D7 sequences. Usually it is not necessary to
detect these nonfunctional hybrid alleles as they not contribute to CYP2D6
metabolizer status (see category A samples in Table 7).

The intron 2 and/or intron 6 assays should be run, in addition to the exon 9 assay,
when information for both CYP2D6 and hybrid alleles is needed (see Table 7), for
example, to characterize samples that are:

* Category B—0 copies for the exon 9 assay, but show amplification by SNP assays
upstream of exon 9 may carry a *36 allele.

* Category C—single copy for the exon 9 assay, but are heterozygous for SNPs
upstream of exon 9 may carry a *36 allele.

* Category D—single copy for the exon 9 assay, but 5" located SNP assays do not
amplify and may carry a *13 allele.

¢ Category E—2 copies for the exon 9 assay and carry a *13 allele. Such samples,
which are relatively rare, are difficult to detect unless all 3 CYP2D6 CNV assays
are routinely run.

Pharmacogenomics Experiments Application Guide 17
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Table 7 Example CYP2D6 SNP and copy number assay results for samples carrying hybrid alleles with CYP2D7

sequences
SNP assay results (cDNA alleles) copy humber assay results | Translation with
Category | Diplotype exon 9 result
100C>T | 1846G>A | 2850C>T | 4180G>C | exon 9 | intron 6 | intron 2 only!"
A *10/*36 T/T G/G c/C c/C 1 2 2 *5/*10
A *2/*36- C/T G/G C/T c/C 2 3 3 *2/*10
*10
A *4/[*36- T/T G/A c/C c/C 2 3 3 *4/*10
*10
A *1/*4N- C/T G/A c/C G/C 2 3 3 *1/*4
*4
B *5/*36 T/T G/G c/C no amp 0 1 1 und (= *5/*5)
C *4/*36 T/T G/A c/C c/C 1 2 2 und (= *4/*5)
C *1/*36- C/T G/G c/C G/G 1 3 3 und (= *5/*1)
*36
D *5/*13F | noamp | noamp | noamp G/G 1 0 0 und (= *5/*5)
E *10/*13E T/T G/G c/C c/C 2 1 1 *10/*10

' und= undetermined

CYP2A6 copy
number variation
and
CYP2A6/CYP2A7
hybrid alleles
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See The Human Cytochrome P450 (CYP) Allele Nomenclature Database CYP2D6 web
page (www.cypalleles.ki.se/cyp2d6.htm) or the PharmGKB web page
(www.pharmgkb.org), plus associated references, for more details about these alleles.

IMPORTANT! Always use the CYP2D6 exon 9 copy number assay to detect true gene
duplication events. CYP2D6 intron 2 or intron 6 copy number assays should not be
used alone to detect CYP2D6 duplications as they will also detect nonfunctional
hybrid alleles that do not represent duplications and that do not contribute to
CYP2D6 metabolizer status.

CYP2AG alleles defined by the Cytochrome P450 Nomenclature Committee
(www.cypalleles.ki.se) include at least four non-functional alleles and several
reduced function alleles. The genotyping of CYP2A6 alleles is complicated by the
presence of copy number variant deletion (*4) and duplication (*1) alleles, and hybrid
alleles formed by recombination with upstream pseudogene CYP2A7 sequences, for
example, the reduced function *12 allele contains exons 1-2 of CYP2A7 origin and
exons 3-9 of CYP2A6 origin (Oscarson, 2002).

Pharmacogenomics Experiments Application Guide
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Several copy number assays to CYP2A6 and CYP2A7 sequences are available for
examining copy number variants and hybrid alleles (see “Pre-tested TagMan® Copy
Number Assays for select DME genes” on page 16 for the complete list).

Table 8 Pre-tested TagMan® Copy Number Assays to CYPAD6 and CYP2A7: detection
of hybrid alleles

*
S RS TR Pl oot 7 e
hybrid]

CYP2A6 Hs07545273_cn | Exon 1 Yes No No
Hs07545274 cn | Intron 1 Yes No No
Hs04488984 cn | Intron 2 Yes Yes No
Hs07545275 cn | Intron 7 Yes Yes No

CYP2A7 Hs07545276_cn Exon 1 No Yes Yes
Hs04488016_cn | Intron 2 No Yes Yes
Hs07545277 cn | Intron 7 No No Yes

At least two assays are required to detect copy number variation in CYP2A6.

¢ The CYP2A6 intron 7 assay can be used to detect *4 deletion and *1 duplication
alleles. This assay will amplify both full length CYP2A6 and the partially active
CYP2A6/CYP2A7 hybrid allele, CYP2A6*12, but will not be able to discern them.

¢ The intron 1 assay can also be used to detect *4 deletion and *1 duplication
alleles. This assay will amplify full length CYP2A6 but will not be able to amplify
the CYP2A6*12 hybrid allele.

¢ If both CYP2AG6 assays are run, samples containing *12 alleles can be
distinguished from those containing full-length alleles. For example, a *1/*12
sample will give 2 copies using the intron 7 assay and 1 copy using the intron 1

assay, whereas a *1/*1 sample will give 2 copies with both assays.

Additionally, CYP2A7 assays can be used to corroborate the presence of CYP2A6*12
alleles: The CYP2A7 exon 1 assay will amplify the hybrid CYP2A6*12 allele, whereas
the intron 7 assay will not amplify intact CYP2A6 or the CYP2A6*12 allele.

Pharmacogenomics Experiments Application Guide
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The GSTM1 and GSTT1 genes have a very high frequency of deletion and are entirely
missing in a substantial number of individuals in multiple populations. DME
genotyping assays to variants within these genes will not amplify samples that are
homozygous for the gene deletion; samples that are heterogyous for the deletion will
run as a homozygous sample.

Gender-specific assays in PGx studies can aid sample tracking. The TagMan® SNP
Genotyping Assay, C_990000001_10, targets a gender-specific polymorphic region in
the amelogenin gene that is commonly used in forensic sex determination tests. The
VIC™ dye probe detects a 6 base deletion which occurs in the X-specific amelogenin
gene, whereas the FAM™ dye probe detects Y-chromosome sequences. In genotyping
experiments, male samples run in the heterozygous cluster position and female
samples run in the VIC™ homozygote cluster. Some males lack the Y-specific
amelogenin gene, and will type as female. Run the C_990000001_10 assay in
combination with a Y-chromosome assay to identify any mistyped samples. For more
information, go to www.cstl.nist.gov/strbase/Amelogenin.htm.

An example of a genotyping bar code Y-chromosome assay is the C___1083232_10
assay to the polymorphic rs2032598 SNP in USP9Y. Only male samples amplify with
this assay; female samples will cluster with the no template controls (NTCs).

TagMan® SNP Genotyping Assays for non-ADME PGx targets and clinical research
targets are often included in PGx studies. These assays are found within the
predesigned TagMan® SNP Genotyping Assays collection and are searchable on the
Thermo Fisher Scientific web site by NCBI dbSNP rs ID. Note that common names for
disease-associated alleles (for example, Factor V Leiden) are not yet searchable terms.
Public web sites that can be used to identify the rs ID for common disease alleles
include:

* Pharmacogenomics Knowledge Base (PharmGKB): www.pharmgkb.org
* Online Mendelian Inheritance in Man™ (OMIM®): http://omim.org/
* SNPedia (a wiki investigating human genetics): http://snpedia.com/
In addition, TagMan® SNP Genotyping Assays for commonly tested clinical research

targets are included in the PGx Common Markers file. Download the PGx Common
Markers file from www.thermofisher.com/pgx.

TagMan® SNP Genotyping Assays are an ideal technology for interrogation of most
DME and clinical research target polymorphisms, offering highly specific target
amplification and allele discrimination. However, there are some polymorphisms that
are not well-suited for TagMan® Assay development. These include targets that:

¢ Reside in highly polymorphic genomic regions (polymorphisms interfere with
amplification in some samples)

* Share high sequence identity with another genomic region (base differences are
not available for specific assay development)

¢ Are microsatellite polymorphisms

* Are base deletions within a homopolymer sequence
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The PGx Common Markers file (www.thermofisher.com/pgx) contains a list of
commonly requested DME and clinical research targets that are not good candidates
for TagMan® Assay design and suggestions for alternative technologies to use (see the
'No TagMan Assays' tab).

Targets of interest that are not covered by the current TagMan® SNP Genotyping
Assay collection can be submitted for Custom TagMan® SNP Genotyping Assays
design.

The Custom TagMan® Assays Design Tool (CADT) is available at
www.thermofisher.com/tagmansnpdesign.

Order Custom TagMan® SNP Genotyping Assays by first entering a sequence with the
SNP in brackets, for example [A/G], then submitting the chosen target sites for assay
design. See www.thermofisher.com/tagmansnpdesign.

CADT is used to design assays targeting biallelic SNPs or insertion/deletion
polymorphisms and multi-nucleotide polymorphisms (MNPs) that are 6 bases or
fewer in length.

Sequences must be SNP and repeat-masked before submission to CADT. Additionally,
the genome-uniqueness for assays must first be established, because custom assays
are not compared to the genome (for example, by BLAT or BLASTn) to determine
target specificity. Do not submit targets from the “No TagMan Assays” tab (see “PGx
targets not amenable to TagMan® design” on page 20), as assays can be designed that
do not function properly.

For targets that present assay design challenges, contact our fee-for-design custom
assay design service at custom.solutions@lifetech.com.

Targets of interest that are not covered by the extensive human TagMan® Copy
Number Assays collection can be submitted to TagMan® Copy Number Assays
design. The GeneAssist™ Copy Number Assay Workflow Builder is available at
www.thermofisher.com/order/custom-genomic-products/tools/
copy-number-variation.

Tools for finding PGx TaqMan® DME, SNP, and Copy Number Assays

* Assay search tool available at www.thermofisher.com/ordertagman

e TagMan® Drug Metabolism Genotyping Assays Index available at
www.lifetechnologies.com/tagmanandme

* PharmaADME Core Marker Set available at http://tools.lifetechnologies.com/
content/sfs/brochures/cms_082106.xls

* PGx Common Markers file available at www.thermofisher.com/pgx
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Assay Search tool

Search for
TagMan® SNP

Genotyping Assays
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The Thermo Fisher Scientific web site provides an easy-to-use assay search tool to aid
selection of TagMan® DME, SNP and Copy Number Assays. The search tool can be
accessed from the Real-Time PCR Assays page or any of the specific product pages at
thermofisher.com.

Go to www.thermofisher.com/ordertaqgman.

2. Select SNP Genotyping.

Assay Search Tool - Find & Buy Your Single Tube TagMan® Assays:

What type of experiment are you conducting?

\\I/; Gene Expression '\E/ SNP Genotyping g_l Copy Number é‘? siRNA
i s

Q MicroRNA ?1/ Mutation Detection ‘\r’ Antibodies

What type of assay do you want?

All SNP Genotyping Drug Metabolism Assays

What species do you want to target? (Select one or more)

[Hs] Human [Mm] Mouse All

* Enter target information
e.g., Assay |D, dbSNP 1D, Gene Symbol, hCV ID

[© Enter/Upload Multiple Targets

Include 10kb Flanking Region

What chromosome position are you interested in?

Number Position/Start Position/Stop

v

Search

3. Select All SNP Genotyping » Human (includes the DME Assays) or just the

validated Drug Metabolism Assays collection.

Enter target information, then click Search to search the complete assay set.

Optionally, specify other search terms (including allele nomenclature, rs ID and
Assay ID) or specify chromosome position. Use the Enter/Upload Multiple
Targets option to specify multiple search terms.

Note: If allele nomenclature is used as a search term (for example, CYP2D6*4),
all DME assays to variants within all associated sub-alleles will be returned. If
needed, review the variants on the associated allele nomenclature website to
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determine which are important to evaluate in your study (for example, only the
allele-defining variants may be of interest).

IMPORTANT! Read any Important Information notes associated with the assay
(select Important Information beside the Assay ID on the assay search results
bar to open a pop-up window). These notes provide information required for
making ordering decisions. For example, a copy number assay may be required
in addition to the DME assay for sample genetic analysis, or the DME assay may
be one of a pair of assays interrogating a triallelic SNP.

5. To review the information for each assay, click View Assay on Map, View
Details, and View Allele Frequency (if available).

Note the following:
* Read any Important Information notes associated with the assay (select

Important Information next to the Assay ID). Notes provide information
required to make ordering decisions and analyze data.

* The annotation for triallelic SNP assays is associated with the SNP ID and
not to the assay. Review the Important Information or the assay context
sequence to determine the target alleles of each assay.

e (lick View Details to review allele nomenclature for CYP, UGT, and NAT
genes.

6. To prepare a list of assays for ordering, select the assays of interest, then click
Export (at the top of the page).

The exported results contain the Assay ID and annotations (catalog number, SNP,
gene, context sequence, genomic location, and allele nomenclature).
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Go to www.thermofisher.com/ordertagman.

2. Select Copy Number » Human.

Assay Search Tool - Find & Buy Your Single Tube TagMan Assays:

What type of experiment are you conducting?

EI:(.I-I- Gene Expression tE/ SHP Genotyping = |
- ( i
9 MicroRNA ?_;f} Mutation Detection \\ r’ Antibodies @ Engineered Cell Models

Copy Number é' siRHA

Which Copy Number product{s) are you interested in using?

All Copy Number Assays Markers & Reporters

What species do you want to target? (Select one or more)

[Hs] Human [Mm] Mouse All

@ Enter target information

Assay ID, Gene Symbol/Mame, Refseqg, DG

2 Enter ! Upload Multiple Targets

1 What chromosome position are you interested in?

Number Position/Start Position/Stop

B

3. Enter target information. Search terms include gene symbol, Assay ID, and

Database of Genomic Variants (DGV) variation IDs.

e Under Narrow Your Results (to the left of the results), select the Gene name
and Pre-tested Assay filters.

* Use the Enter/Upload Multiple Targets option to specify multiple search
terms.

* Specify chromosome position.
Note: Copy Number Assays must be run in duplex PCR with a TagMan® Copy

Number Reference Assay; RNase P (default assay) and TERT (alternate assay)
assays are available.

IMPORTANT! Read any Important Information notes associated with the assay
(select Important Information beside the Assay ID on the assay search results
bar to open a pop-up window). These notes provide information required for
making ordering decisions. For example, information on the particular star
alleles that an assay detects.

4. Click Search to search the complete assay set.
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5. When applicable, narrow results by selecting Pre-Tested Assays to view assays
pre-tested on 90 Coriell gDNAs.

6. Review the information for each assay: click View Assay on Map and View
Details.

Note the following:

* Read any Important Information notes associated with the assay (click the
Important Information box next to an Assay ID). Notes provide information
required to make ordering decisions, then analyze data.

* View Details provides target location within gene and targeted known copy
number variants.

7. If you need a list of assays for ordering, select the assays of interest, then click
Export (at the top of the page).
The exported results contain the assay ID and annotations (catalog number, gene,
genomic location, and DGV targets).

Note: TagMan® Copy Number Assays must be run in duplex PCR with a
TagMan® Copy Number Reference Assay: RNase P (default assay) and TERT
(alternate assay) assays are available.

The TagMan® Drug Metabolism Genotyping Assays Index contains a comprehensive
list of the DME assays along with the annotations listed below. This file can facilitate
looking for DME assays to polymorphisms of interest given the extensive annotation
information within it, which includes:

* Gene symbol and name

* NCBI SNP reference (if applicable)

¢ Polymorphism (for example, A/G)

* Amino acid change (if applicable)

e Allele nomenclature (if available)

¢ Polymorphism (for example, A/G)

¢ SNP type (for example, missense mutation)

e Context sequence [VIC"/FAM™] (in (+) strand orientation with SNP alleles in
brackets)

* Applied Biosystems™ minor allele frequency data (Caucasian, African American,
Japanese, Chinese populations)

The PharmaADME consortium (www.PharmaADME.org) created a consensus list of
known and putative functional variants in key genes involved in the absorption,
distribution, metabolism, and excretion (ADME) of drugs. The PharmaADME Core
Marker Set contains a list of variants considered most likely to impact drug
metabolism, and is composed of 184 variants in 33 key ADME genes.

Thermo Fisher Scientific developed TagMan® Assays to the PharmaADME Core
Markers (> 95% coverage). This assay set is comprised of both TagMan® DME and
Copy Number Assays to 172 SNP, InDel, and CNV targets:

* 164 DME assays include 10 assays to genotype 5 triallelic SNPs (paired assays)

* 10 copy number assays cover deletions and duplications in 6 total DME genes
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The PGx Common Thermo Fisher Scientific has pretested over 300 TagMan® DME and SNP Assays to

Markers file highly studied, important DME and other PGx gene variants on OpenArray™ plates
run on the QuantStudio™ 12K Flex Real-Time PCR System. All assays on this list were
tested on this system with 44 Coriell gDNAs (22 each African American and
Caucasian samples, a subset of the DME Assay 90 sample validation panel) and most
were also tested with synthetic plasmid constructs representing each genotype. The
PGx Common Markers file contains a list of the most commonly requested assays
from this set.

The file includes common allele names, context sequences, and other useful
annotations.

Note: A presentation called TagMan® Drug Metabolism Genotyping Assays on
OpenArray™ Plates contains screen shots of the test data for the most commonly
requested PGx Marker Assays (download from www.thermofisher.com/pgx).

Plate products and formats

Fixed TagMa n® There are two fixed TaqMan® OpenArlrayTM PGx panels available for use on the
Open Array“" PGx QuantStudio " 12K Flex Real-Time PCR System:
panel plates o TaqMan® OpenArraym PGx Panel, QuantStudio 12K Flex (Cat. No. 4475395
e TagMan® OpenArray PGx Express Panel, QuantStudio 12K Flex (Cat. No.
4488847
Order custom 1. Go to www.thermofisher.com/order/custom-array/.
OpenArray™

plates 2. For array type, select TagMan® OpenArray” Genotyping Plates.

3. Click View Layout to display the assay format in a plate.

4. Click Select to configure a plate.

Array name* Array ID  Array type Format Unique Targets Filled Invalid Empty
TagqMan® OpenArray® Genotyping Plates MO 0 ﬂ n n
Select Edit Move Export Help Save Your Array
sel says | C y | C
1 2
Display
i Sub Array Al
Filled
Invalid
Empty
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. Click Import Your Assay List, then provide assay information.

¢ Under Upload a list of Assay IDs, click Choose File, then select a tab-
delimited text file (.txt) containing Assay IDs.

or

¢ Under Enter a list of Assay IDs, paste the Assay IDs, then click Import
Entered List.

. Follow the screen instructions to configure the assays on the plate.

. (Optional) Click Save Your Array at any time to save the array configuration to

your Thermo Fisher Scientific account.

. When the plate is configured, click Complete Your Design, then follow the

screen instructions to complete the order.

Single tube products and formats

Order single-tube
TagMan® assays

Formats for DME
and CNV assays

Order single-tube assays in two ways:

Search for TagMan® Assays, add assays to the shopping cart, then complete the
order.

If you have already obtained catalog numbers and IDs (Assay IDs), click Quick
Order at the top of any page at thermofisher.com.

TagMan® SNP Genotyping Assays

Table 9 Single-tube TagMan® SNP Genotyping Assays

tem Scale Number of reactions Assay m_ix Cat. No.
384-well | 96-well | formulation |y oh | Non-human
Predesigned Small 1,500 300 40X 4351379 N/A
>NP Medium 5,000 1,000 4351376
Large 12,000 2,400 80X 4351374
DME Small 750 150 20X 4362691
Custom SNP Small 1,500 300 40X 4331349 4332077
Medium 5,000 1,000 4332072 4332075
Large 12,000 2,400 80X 4332073 4332076

Note: For more detailed instructions on running SNP genotyping experiments with
single tube assays, see the TagMan® SNP Genotyping Assays User Guide (Pub. No.
MANO0009593).
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DME assays are available only as small scale inventoried product. Predesigned and
custom SNP assays are made-to-order and are available in multiple scales.

Assays with human part numbers undergo functional testing on a panel of 20
unrelated Coriell cell line gDNA samples from 3 populations (African American,
Caucasian, and Japanese) before shipment upon first order.

Custom non-human part numbers can be applied to assays for human targets that

would fail the human assay functional test (for example, Y chromosome SNP assays
fail as 8 of 20 samples are female and will not amplify; GSTT1 and GSTM1 SNP assays
will also fail due to the high frequency of gene deletion).

TaqMan® Copy Number Assays

Table 10 Made-to-order assays

Numlt)'er of Cat. No. (Human)
reactions Assay mix
gEa formulation :
384-well | 96-well Pre-designed | Custom Custom
assays Plus assays assays

Small 720 360 20X 4400291 L4L4L248T 4400294
Medium 1,500 750 4400292 4442520 4400295

Large 5,800 2,900 60X 4400293 4442488 4400296
Table 11 Inventoried assays

Number of reactions :
Item fAssa)I T.'x Cat. No.
384-well | 96-well | 'ormutation

TagMan® Copy Number Reference Assay 1,500 750 20X 4403326
RNase P (1 tube)
TagMan® Copy Number Reference Assay 6,000 3,000 20X 4403328
RNase P (4 tubes])
TagMan® Copy Number Reference Assay 1,500 750 20X 4403316
TERT (1 tube])
Taq Man® Copy Number Reference Assay 6,000 3,000 20X 4403315
TERT (4 tubes)

28
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Options for master mixes

Options for master mixes

TaqMan® OpenArraylM Genotyping Master Mix is required for use with OpenArray
plates. TaqPath” ProAmp " Master Mix is recommended for optimal performance
with TagMan® Copy Number Assays for pharmacogenomics applications.

ltem Use Cat. No.

TagMan® OpenArray™ Genotyping OpenArray” genotyping 4404846
Master Mix

TagPath™ ProAmp"™ Master Mix Copy number A30865

experiments (ROX™]
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Kit contents and storage

30

Cat. No. Cat. No.
Component A2559701 A25598!2] Storage
(500 rxns) (2,500 rxns)
Proteinase K& 4mL 5x 4 mL -25°C to -15°C
PK Buffer 96 mL 5x 96 mL
. ) 15°C to 30°C
Multi-Sample DNA Lysis 100 mL 5 x 100 mL
Buffer
RNase Al4] 2x1.25mL 10 x 1.25 mL -25°C to -15°C
DNA Binding Beadsl®! 8 mL 5x8mL 2°C to 8°C
Nuclease-free Water 100 mL 5x 100 mL
Wash Solution 1 5] 5]
Concentrate 80 mL 5x80mL 15°C to 30°C
Wash Solution 2 162 mLs] 5 x 162 mLS]
Concentrate
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Required materials not supplied
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Cat. No. Cat. No.
Component A25597M A25598!2] Storage
(500 rxns) (2,500 rxns)
DNA Elution Buffer 1 25 mL 5x 25 mL
15°C to 30°C
DNA Elution Buffer 2 25 mL 5x25mL

1 Also available as Cat. No. A25919, containing Cat. No. A25597 with one additional tube each of Proteinase K

(4 mL) and DNA Binding Beads (8 mL).
[2

each) and 5 additional tubes of DNA Binding Beads (8 mL each).

Also available as Cat. No. A25920, containing Cat. No. A25598 with 5 additional tubes of Proteinase K (4 mL

Bl Proteinase K is also available as Cat. no. A25561 and DNA Binding Beads are also available as Cat. No. A25562.

[4]
[5]

Not used for DNA isolation from buccal swabs.
Final volume; see “Before first use of the kit" on page 34.

Required materials not supplied

Unless otherwise indicated, all materials are available through thermofisher.com.
MLS: Fisher Scientific (fisherscientific.com) or other major laboratory supplier.

Table 12 Required materials and equipment not included with the kit

Item Source
One of the following instruments
[Recommended] KingFisher™ Flex Magnetic Particle Processor 5400630
MagMAX"™ Express-96 Magnetic Particle Processor —m
Equipment
Plate shaker, capable of shaking plates at a minimum of 900 rpm 88880023
Analog Vortex Mixer Fisohzeir215§§r;t5ific
Adjustable micropipettors MLS
Multi-channel micropipettors MLS
(Optional/Magnetic Stand-96 AM10027
Plates and combs
Deep Well Plates, one of the following:
KingFisher™ Flex Microtiter Deepwell 96 plates, sterile 95040460
MagMAX"™ Express-96 Deep Well Plates 4388476
Standard Well Plates, one of the following:
KingFisher™ 96 KF microplates 97002540
MagMAX™ Express-96 Standard Plates 4388475
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S Required materials not supplied
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Item Source

Tip Combs, one of the following:

KingFisher™ 96 tip comb for DW magnets 97002534
MagMAX™ Express-96 Deep Well Tip Combs 4388487
Other consumables

MicroAmp™ Clear Adhesive Film 4306311
RNase-free Microfuge Tubes (2.0 mL]) AM12425
Conical tubes (15 mL) AM12500
Conical tubes (50 mL]) AM12502
Aerosol-resistant pipette tips MLS
Reagent reservoirs MLS
(Optional) Paraffin film MLS
Reagents

Ethanol, 200 proof (absolute) MLS
Isopropanol, 100% (molecular grade or higher]) MLS

' Not available for sale.

Table 13 Additional materials and equipment required for processing buccal swabs

Item Source
Laboratory incubator with slatted shelves, capable of maintaining
o MLS

65°C
One of the following types of buccal swabs, or equivalent buccal swabs with foam tips:

o ™ Fisher Scientific
Puritan PurFlock = Ultra Flocked Swabs 22-025-192

. ™ . Puritan
Puritan  HydraFlock Swabs, standard tip 25-3306-H

. . Puritan
Sterile Foam Tipped Swabs 25-1506 1PF
4N6FLOQSwabs™, regular tip 4473979
[Optional] Proteinase K, 500 reactions (4 mL) A25561
[Optional/ DNA Binding Beads, 500 reactions (8 mL) A25562
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Download the KingFisher™ Flex program (if needed)
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Table 14 Additional materials and equipment required for processing whole blood

samples
Item Source
Laboratory incubator with slatted shelves, capable of maintaining
o MLS
65°C
(Optional] Proteinase K, 500 reactions (4 mL) A25561
[Optional/ DNA Binding Beads, 500 reactions (8 mL) A25562

Download the KingFisher " Flex program (if needed)

The program required for this protocol is not pre-installed on the KingFisher  Flex

Magnetic Particle Processor.

1. On the MagMAX™ DNA Multi-Sample Ultra Kit web page, scroll down to the
Product Literature section.

2. Click A25597_Blood_Buccal to download the program to your computer.

3. See Thermo Scientific™ KingFisher™ Flex User Manual (Cat. No. N07669) and
BindIt™ Software User Manual (Cat. No. N07974) for instructions for installing the
program on the instrument.

Set up the sample layout

Set up the sample plate layout using either of the following tools, which provide
sample tracking from the 96-well plate used for DNA isolation to the 96-well sample
plate .csv file used for import into OpenArray™ Sample Tracker Software.

Include at least 2 no template controls (NTCs) per plate.

Tool

Obtain from

Description

OA_Genotyping_CalcSheet

thermofisher.com/oaqrc

Contains a sample layout
tab, additional sample
tracking tabs, and
instructions for using an
adjustable pipettor to
transfer samples from the
96-well plate to the 384-well
sample plate.

96-well Sample Plate 1.csv
template

On the computer on which
the Sample Tracker
Software is installed:

C:\Program Files\Applied
Biosytems\Sample Tracking
Utility\examples

Contains a sample layout
tab.

Pharmacogenomics Experiments Application Guide
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Isolate DNA from buccal swabs

Isolate DNA from buccal swabs

™

This section contains brief procedures. For detailed information, refer to MagMAX
DNA Multi-Sample Ultra Kit (human buccal swabs) User Guide (Pub. No. MAN0010293).

Refer to Best Practices for Collection of Buccal Swabs Quick Reference (Genotyping
Experiments) (Pub. No. MAN0014348) for sample collection instructions.

Guidelines for * Perform all steps at room temperature (20-25°C) unless otherwise noted.
buccal swab ¢ Equilibrate buccal swabs to room temperature to maximize DNA recovery.
preparation e Remove the buccal swabs from the lysate:

— Option 1 (Preferred): Transfer the lysate to a new plate.
This option eliminates contamination risks and saves time. To transfer
lysates, set a multi-channel micropipettor to ~300 puL and transfer one row at
the time. Each well should contain 200-250 pL after transfer.

— Option 2: Remove the swabs from the plate using forceps.

Rinse the forceps in 70% ethanol between samples, to prevent cross-
contamination. Press the swabs against the side of the well when removing
them, to prevent sample loss.

e Cover the plate during the incubation and shaking steps to prevent spill-over and
cross-contamination. The same MicroAmp Clear Adhesive Film can be used
throughout the procedure, unless it becomes contaminated.

¢ If you use a plate shaker other than the recommended shaker, verify that:
— The plate fits securely on your plate shaker.

— The recommended speeds are compatible with your plate shaker. Ideal
shaker speeds allow for thorough mixing without splashing.

* Per-plate volumes for reagent mixes are sufficient for one plate plus overage. To
calculate volumes for other sample numbers, refer to the per-well volume and
add 5% overage.

* (Optional) To prevent evaporation and contamination, cover the prepared
processing plates with paraffin film until they are loaded into the instrument.
tional) Guidelines for improving yields
(Optional) Guidelines for improving yield

¢ This procedure is optimized for processing of one swab per well. It is possible to
process two swabs in one well when a higher concentration of DNA is required.

e If the DNA yield is lower than expected, extend the Proteinase K digestion to
45 minutes.

¢ To further improve recovery, digest with Proteinase K overnight at 50°C.

Before first use of Prepare the Wash Solutions from the concentrates:

the kit * Add 25 mL of isopropanol to Wash Solution 1 Concentrate, mix, and store at
room temperature.

e Add 132 mL of ethanol to Wash Solution 2 Concentrate, mix, and store at room
temperature.
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Isolate DNA from buccal swabs

Before each use of
¢ Preheat the incubator to 65°C.
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the kit
* Vortex DNA Binding Beads thoroughly, then combine with Nuclease-free Water
according to the following table.
Component Volume per well Volume per plate
DNA Binding Beads 16 uL 1.6 mL
Nuclease-free Water 24 pL 2.4 mL
Total DNA Binding Bead Mix 40 pL 4 mL
Store DNA Binding Bead Mix at room temperature for up to 24 hours.
Digest the Ensure that the incubator is preheated to 65°C.
samples with 1. Place the swab, swab-head down, in a deep-well plate (one per well).

Proteinase K

If two swabs were collected, store the second swab as a backup sample.

2. Break enough of the stick off the swabs so that the swabs sit in the wells without

protruding.

3. Prepare sufficient PK Mix according to the following table, then invert several

times to thoroughly mix components.

IMPORTANT! Prepare the PK Mix just before use. Do not place the PK Buffer or

the PK Mix on ice, to avoid precipitation.

Component Volume per well Volume per plate
Proteinase K 8yl 800 pL
PK Buffer 192 uL 19.2 mL
Total PK Mix 200 pL 20 mL

4. Add 200 uL of PK Mix to each sample well of a deep-well plate (PK Plate)

containing a swab.

IMPORTANT! Do not touch any part of the swab with the pipet tip when

pipetting the PK Mix in the sample wells.

5. Seal the plate with a clear adhesive film, then shake the sealed plate for 5 minutes

at 900-950 rpm.

6. Incubate for 20-45 minutes at 65°C.

IMPORTANT! Arrange plates in the incubator to allow adequate flow around the
plate wells, to ensure that samples quickly reach and maintain the incubation

temperature.

Pharmacogenomics Experiments Application Guide
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. Isolate DNA from buccal swabs

et up the . 1le the samples are incubating at , set up the Wash, Elution, and 11
p th 1. While th pl incubating at 65°C p the Wash, Eluti d Tip
processing plates Comb Plates outside the instrument as described in the following table.
Plate ID Plate position[” Plate type Reagent Volume per well
Wash Plate 1 2 Deep Well Wash Solution 1 150 pL
Wash Plate 2 3 Deep Well Wash Solution 2 150 pL
Wash Plate 3 4 Deep Well Wash Solution 2 150 pL
Elution Platel? 5 Standard DNA Elution Buffer 1 50 L
Tip Comb 6 Deep Well Place a tip comb in the plate.

01 Position on the instrument
21 The instrument prompts the user to add DNA Elution Buffer 2 to the Elution Plate, after incubation with DNA Elution Buffer 1.

2. (Optional) To prevent evaporation and contamination, cover the prepared
processing plates with paraffin film until they are loaded into the instrument.

Add Multi-Sample 1. (Optional) If condensation is present at the end of the 65°C incubation, briefly

DNA Lysis Buffer, centrifuge the plate for 1-2 minutes at 1,500 x g.

iSOpropanol, and 2. Add 200 uL of Multi-Sample DNA Lysis Buffer to each sample

DNA Binding Bead = P y ple.

Mix 3. Seal the plate with a clear adhesive film, then shake for 5 minutes at 900-
950 rpm.

4. Transfer lysates to the wells of a new deep-well plate and discard the plate
containing the buccal swabs.

5. Add 240 pL of isopropanol to each sample, seal the plate, then shake for
5 minutes at 900-950 rpm.

6. Vortex DNA Binding Bead Mix at moderate speed to ensure thorough mixing,
add 40 pL to each sample, then proceed immediately to DNA isolation (next
section).

If you see that the beads in the DNA Binding Bead Mix are settling, vortex the
mix again briefly before continuing to pipette.

Process samples 1. Select the program on the instrument.

on the instrument * KingFisher™ Flex Magnetic Particle Processor: A25597_Blood_Buccal
e MagMAX"™ Express-96 Magnetic Particle Processor: 4413021 DW blood

2. Start the run, remove the temporary paraffin plate seals (if present), then load the
prepared processing plates in their positions when prompted by the instrument.

3. Load the PK plate (containing lysate, isopropanol, and DNA Binding Bead Mix)
at position 1 when prompted by the instrument.

4. When prompted by the instrument (approximately 28-30 minutes after initial
start):

a. Remove the Elution Plate from the instrument.
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b. Add 50 uL of DNA Elution Buffer 2 to each sample well.

IMPORTANT! Add DNA Elution Buffer 2 immediately after the prompt, to
prevent excessive drying of any beads that are still captured on the Tip
Comb.

c. Load the Elution Plate back onto the instrument, and press Start.

5. At the end of the run (approximately 30-35 minutes after initial start), remove
the Elution Plate from the instrument and seal immediately with a new clear
adhesive film.

* (Optional) Eluates can be transferred to a new storage plate after collection.

» If precipitated DNA is visible, pipet up and down 5-10 times before sealing
the plate, to ensure complete resuspension.

e If you see excessive bead residue in the wells, place the Elution Plate on the
Magnetic Stand-96 to capture any residue prior to downstream use of the
DNA.

IMPORTANT! Do not allow the purified samples to sit uncovered at room
temperature for more than 10 minutes, to prevent evaporation and
contamination.

The purified samples are ready for immediate use. Alternatively, store the covered
Elution Plate:

* At 2-6°C for up to 24 hours.
* At-20°C or -80°C for long-term storage.

Isolate DNA from whole blood

Sample collection
and storage

Guidelines for
whole blood
preparation

™

This section contains brief procedures. For detailed information, refer to MagMAX
DNA Multi-Sample Ultra Kit (whole blood) User Guide (Pub. No. MAN0010294).

Sample collection: Collect blood samples using proper venipuncture collection
and handling procedures in EDTA or sodium citrate anticoagulant tubes. Invert
the tube to ensure thorough mixing.

Note: Heparin is not recommended as an anti-coagulant since it can cause
inhibition of PCR.

* (Optional) Sample storage: Store samples between -20°C and -80°C. We
recommend storing samples in smaller volumes to prevent multiple freeze/thaw
cycles.

e If the whole blood is frozen prior to use, thaw the sample at 25-37°C in a water
bath until it is completely liquid, then place on ice until needed.

* Perform all steps at room temperature (20-25°C) unless otherwise noted.
¢  When mixing samples by pipetting up and down, avoid creating bubbles.

* Cover the plate during the incubation and shaking steps to prevent spill-over and

cross-contamination. The same MicroAmp™ Clear Adhesive Film can be used
throughout the procedure, unless it becomes contaminated.
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¢ If you use a plate shaker other than the recommended shaker, verify that:
— The plate fits securely on your plate shaker.

— The recommended speeds are compatible with your plate shaker. Ideal
shaker speeds allow for thorough mixing without splashing.

* Per-plate volumes for reagent mixes are sufficient for one plate plus overage. To
calculate volumes for other sample numbers, refer to the per-well volume and
add 5% overage.

o If the DNA yield is lower than expected, extend the Proteinase K digestion to
45 minutes.

Before first use of Prepare the Wash Solutions from the concentrates:

the kit e Add 25 mL of isopropanol to Wash Solution 1 Concentrate, mix, and store at
room temperature.

e Add 132 mL of ethanol to Wash Solution 2 Concentrate, mix, and store at room
temperature.

Before each use of Preheat the incubator to 65°C.

the kit

Digest the Ensure that the incubator is preheated to 65°C.

sam p.les with 1. Prepare sufficient PK Mix according to the following table, then invert several
Proteinase K times to thoroughly mix components.

IMPORTANT! Prepare the PK Mix just before use. Do not place the PK Buffer or
the PK Mix on ice, to avoid precipitation.

Component Volume per well Volume per plate
Proteinase K 8L 800 pL
PK Buffer 192 pL 19.2 mL
Total PK Mix 200 pL 20 mL

2. Add 200 pL of PK Mix to each sample well of a deep-well plate (PK Plate).

3. Transfer 50 uL of whole blood to the appropriate well containing PK Mix.

IMPORTANT! Invert the tube containing the blood sample before pipetting to
ensure homogenous mixing.

4. Seal the plate with a clear adhesive film, then shake the sealed plate for 5 minutes
at 900-950 rpm.

5. Incubate for 20-45 minutes at 65°C.

IMPORTANT! Arrange plates in the incubator to allow adequate flow around the
plate wells, to ensure that samples quickly reach and maintain the incubation
temperature.
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et up the . 1le the samples are incubating at , set up the Wash, Elution, and 11
p th 1. While th pl incubating at 65°C p the Wash, Eluti d Tip
processing plates Comb Plates outside the instrument as described in the following table.
Plate ID Plate position[” Plate type Reagent Volume per well
Wash Plate 1 2 Deep Well Wash Solution 1 150 pL
Wash Plate 2 3 Deep Well Wash Solution 2 150 pL
Wash Plate 3 4 Deep Well Wash Solution 2 150 pL
Elution Platel? 5 Standard DNA Elution Buffer 1 50 L
Tip Comb 6 Deep Well Place a tip comb in the plate.

1 Position on the instrument

21 The instrument prompts the user to add DNA Elution Buffer 2 to the Elution Plate, after incubation with DNA Elution Buffer 1.

Add Multi-Sample
DNA Lysis Buffer,
isopropanol, and
Bead/RNase A Mix

Pharmacogenomics Experiments Application Guide
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(Optional) To prevent evaporation and contamination, cover the prepared
processing plates with paraffin film until they are loaded into the instrument.

(Optional) If condensation is present at the end of the 65°C incubation, briefly
centrifuge the plate for 1-2 minutes at 1,500 x g.

2. Add 200 pL of Multi-Sample DNA Lysis Buffer to each sample.

Seal the PK plate with a clear adhesive film, then shake for 5 minutes at 900-
950 rpm.

Prepare Bead/RNase A Mix according to the following table.

IMPORTANT! Prepare the Bead/RNase A Mix no more than 20 minutes before
use. Prolonged storage at room temperature can reduce its efficiency.

Vortex the DNA Binding Beads at moderate speed to form a uniform suspension
before preparing the Bead/RNase A Mix.

Component Volume per well Volume per plate
DNA Binding Beads 16 uL 1.6 mL
RNase A 5uL 500 pL
Nuclease-free Water 19 uL 1.9 mL
Total Bead/RNase A Mix 40 uL 4.0 mL

Vortex the Bead/RNase A Mix at moderate speed to ensure thorough mixing,
then add 40 pL to each sample and pipet up and down 5 times using a
multi-channel micropipettor.

If you see that the beads in the Bead/RNase A Mix are settling, vortex the mix
again briefly before continuing to pipette.

Seal the PK plate with the clear adhesive film, then shake for 5 minutes at 900-
950 rpm.

Add 240 pL of isopropanol to each sample, then proceed immediately to DNA
isolation (next section).
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Process samples 1. Select the program on the instrument.

on the instrument ¢ KingFisher™ Flex Magnetic Particle Processor: A25597_Blood_Buccal
e MagMAX"™ Express-96 Magnetic Particle Processor: 4413021 DW blood

2. Start the run, remove the temporary paraffin plate seals (if present), then load the
prepared processing plates in their positions when prompted by the instrument.

3. Load the PK plate (containing lysate, isopropanol, and Bead/RNase A Mix) at
position 1 when prompted by the instrument.

4. When prompted by the instrument (approximately 28-30 minutes after initial
start):

a. Remove the Elution Plate from the instrument.

b. Add 50 uL of DNA Elution Buffer 2 to each sample well.

IMPORTANT! Add DNA Elution Buffer 2 immediately after the prompt, to
prevent excessive drying of any beads that are still captured on the Tip
Comb.

c. Load the Elution Plate back onto the instrument, and press Start.

5. At the end of the run (approximately 30-35 minutes after initial start), remove
the Elution Plate from the instrument and seal immediately with a new clear
adhesive film.

* (Optional) Eluates can be transferred to a new storage plate after collection.

* If precipitated DNA is visible, pipet up and down 5-10 times before sealing
the plate, to ensure complete resuspension.

¢ If you see excessive bead residue in the wells, place the Elution Plate on the
Magnetic Stand-96 to capture any residue prior to downstream use of the
DNA.

IMPORTANT! Do not allow the purified samples to sit uncovered at room
temperature for more than 10 minutes, to prevent evaporation and
contamination.

The purified samples are ready for immediate use. Alternatively, store the covered
Elution Plate:

* At 2-6°C for up to 24 hours.
e At -20°C or -80°C for long-term storage.
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Prepare a DNA stock solution for OpenArray  experiments

The recommended input for OpenArray  plates is 825 pg of DNA per 33-nL reaction.

1. Quantify DNA by any of the following methods. Before quantifying, mix the
samples well to ensure sample homogeneity, especially if samples have been
stored.

* RNase P C; value method (recommended)—See Appendix C, “RNase P
quantification for genotyping experiments”.

¢ Fluorometric analysis—Use a Qubit™ dsDNA BR or HS Assay Kit.

2. Prepare a 50 ng/uL DNA stock solution to use in the PCR setup.

Samples with low concentration (<10 ng/uL) and/or low quality may require
preamplification. See Appendix B, “Preamplification of low-concentration
gDNA”.

Normalize DNA samples for copy nhumber analysis

The required input for each 10-uL PCR is 10 ng of DNA.

Run each sample in quadruplicate for each copy number assay.

1. Dilute a portion of each gDNA sample to 5 ng/uL. Prepare sufficient DNA for the
required number of reactions.

(# of assays) x (Vol. of 5 ng/uL. DNA per 10 uL reaction) x (# of replicates) x 120%
(for dead volume)

For example, if you are running 5 copy number assays, prepare at least:
(5 Assays) x (2 puL) x (4 replicates) x 120%
=48 uL of each sample at a concentration of 5 ng/ uL

2. Store the diluted samples at 4°C for immediate use or at —25°C to —15°C for
long-term storage.
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Prepare and run OpenArray  PGx

SNP genotyping experiments

WOIKElOW ..o 43
Materials required: OpenArray™ plate workflow ......................... 43
Recommended: Run OpenArray™ SNP genotyping experiments in real-

tme mode ... ... 44
Generate 384-well sample plate layouts in the OpenArray™ Sample

Tracker Software ........ ... ... . . 46
Set up the AccuFill™ instrument ........... ... i i 47
Set up the PCR reactions in an OpenArray'" 384-well Sample Plate ... ...... 48
Transfer reactions to the OpenArray™ plate (AccuFill™ instrument) ......... 49
Seal the OpenArray™ plate ...... ... .o i 50
Run the OpenArray™ plate(s) on the QuantStudio™ 12K Flex instrument . ... 51
Checkthe QCImages ...t e 52
One-time procedures ............ ... ... .. i 53
Download SPFFiles ......... ... .. . i i i i 54

This chapter contains brief procedures. For detailed procedures, refer to:

Title Pub. No.
QuantStudio™ 12K Flex Real-Time PCR System: 4470935
OpenArray  Experiments User Guide
OpenArray” Sample Tracker Software Quick Reference 4460657
OpenArray” AccuFill" System User Guide 4456986
OpenArray” SNP Genotyping Experiments MANO0014351
TagMan® OpenArray” Genotyping Troubleshooting Guide MANO0O011115
TagMan® Genotyper Software Getting Started Guide 4448637
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Workflow

Workflow

“Generate 384-well sample plate layouts in the OpenArray” Sample

Tracker Software” on page 46

v

“Set up the PCR reactions in an OpenArray™ 384-well Sample Plate” on

page 48
v

“Set up the AccuFill™ instrument” on page 47

v

“Transfer reactions to the OpenArray " plate (AccuFill™ instrument)” on

page 49
v

“Seal the OpenArray” plate” on page 50

v

“Run the OpenArray™ plate(s) on the QuantStudio” 12K Flex

instrument” on page 51

v

“Check the QC Images” on page 52

Materials required: OpenArray  plate workflow

Unless otherwise indicated, all materials are available through thermofisher.com.
MLS: Fisher Scientific (fisherscientific.com) or other major laboratory supplier.

Item

Source

Genomic DNA, 50 ng/uL

From Chapter 3, “Isolate DNA using the MagMAX™ DNA
Multi-Sample Ultra Kit”

0 penArrayW 384-well Sample Plate

4482221

OpenArray” plates with PGx assays

Custom ordered

TagMan® OpenArray” Genotyping Master Mix

4404846

Biomek Seal and Sample Foil Lids (for pre-plating step)

Beckman Coulter 538619

OpenArray” AccuFill™ System Tips

4458107

QuantStudio™ 12K Flex OpenArray™ Accessories Kit

(contains the items needed to assemble up to 10 plates:

12 lids and plugs, 12 immersion fluid syringes, and
2 carriers])

4469576

OpenArrayW Sample Tracker Software

Download from thermofisher.com.
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Chapter 4 Prepare and run OpenArray™ PGx SNP genotyping experiments
Recommended: Run OpenArray™ SNP genotyping experiments in real-time mode

ltem Source
QuantStudio™ 12K Flex OpenArray™ Plate Press 2.0 A24945
QuantStudio™ 12K Flex instrument with OpenArray™ Contact your local customer service representative.
block (AccuFill™ System)

Recommended: Run OpenArray  SNP genotyping experiments in
real-time mode

We recommend running all OpenArray"™ plates on a QuantStudio™ instrument in real-
time experiment mode. This recommendation allows observation of genotyping data
over time to evaluate the accuracy of genotype calls by observing the location of a
given sample relative to others throughout all cycles.

The following example shows how calls based on end-point reads could be incorrect
when the DNA concentration is higher than the recommended amount.

With real-time Traces

Without Traces

Calls based on end-point reads could be incorrect.

Real-time genotyping graphs used for making accurate
calls when using samples with very high DNA
concentration.

Note: Generally, a Ct value of ~25 indicates that the sample input is approximately
250 haploid copies, which is the recommended input amount per 33-nL reaction for
OpenArray™ genotyping plates. This corresponds to 825 pg of DNA per PCR reaction
using a stock solution of 50 ng/pL.
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Recommended: Run OpenArray™ SNP genotyping experiments in real-time mode — [as’

The default run type for genotyping experiments is real-time mode, indicated by the
selection of Include Amplification in the Setup OpenArray Run window. The default
settings also include the selection of Include Pre-read; this setting is strongly
recommended to correct for background fluorescence on the plate.

Run OpenArray @

Load the reaction plate into the instrument. Select the instrument and enter the setup files, then click Start Run, @

Select Instrument

FOSHAYASHK1L04
READY

Setup Cpendrray Run

[ Get Plate 1Ds ] [ Confirm Plate Centers ] Run Type : Genotyping [ Include Amplification  [#] Include Pre-read

Reagent Type : TagMan

Cpendrray 11 S-DEBO:L | * Setup File :

loaded DEBO1.spf |[ Browse | * Experiment Fle Location : | lex Software\User Files\Experiments | EBrowse |
i Browse * Experiment File Name . |DEBOL_2012_03_05_124756.eds |

Sample File

Cpendrray 2 \ | *SetupFia: | ! Browse * Experiment Fle Location @ | \

* Experiment File Name : | ‘

Opendrray 3 : * Setup File ‘ || Browse * Eyperiment File Location : | ‘

* Expetiment File Mame | ‘

Cpendrray 4 \ | * Setup File ‘ | Browse * Experiment File Location : | \

* Experiment File Name | ‘

-

For additional information about genotyping experiments, see the QuantStudio™ 12K
Flex Real-Time PCR System: OpenArray™ Experiments User Guide (Pub. No. 4470935).
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1| Generate 384-well sample plate layouts in the OpenArray™ Sample Tracker Software

Generate 384-well sample plate layouts in the OpenArray  Sample
Tracker Software

The software maps samples from the 96-well layout used for DNA isolation to a
384-well sample plate layout as *.csv files that are used by OpenArray ~ AccuFill™
software.

See “One-time procedures” on page 53 to:

* Set up optimized folder locations and software preferences before performing
this procedure for the first time.

e Download the *.spf file(s) for the OpenArray " plate(s) before starting.

1. Generate the 96-well sample plate *.csv file using the OA_Genotyping_CalcSheet
or 96-Well Sample Plate 1.csv template, then save it to the Sample Tracker 96-well
Input folder.

The 96-Well Sample Plate 1.csv file is provided in the AccuFill™ software
installation. Enter or copy the sample names in 96-Well Sample Plate 1.csv, then
Save as a new *.csv-format file.

The OA_Genotyping_CalcSheet automatically generates the sample *.csv file.

2. In the Sample Tracker Software Properties screen, select Genotyping for
Experiment Type, then select the appropriate settings for OpenArray™ Plate and
Pipettor.

3. In the Samples screen, click $® Import, then select and import the sample *.csv
file.

4. In the Sample Mapping screen, confirm that the samples for a single
OpenArray™ plate are assigned to one color.

If necessary, correct the OpenArray " Plate and Pipettor settings in the Properties
screen.

5. In the Sample Mapping screen, click the 384-Well Plate tab, then click
Export » Export *.csv.

6. Select 384-Well Plate (for AccuFill), then save the exported file.

Plate layouts for the 384-well sample plates are saved to individual *.csv files in the
Sample Tracker 384-well CSV Files folder.
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Set up the AccuFill™ instrument
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Set up the AccuFill " instrument

IMPORTANT! Before proceeding, check the tip expiration date (shown on the outer
box that contains the trays of tips). Do not use tips that exceed the expiration date.

1. In the OpenArray™ AccuFill™ software, click Setup and Load.

2. In the Setup Load Information window, verify that the Use Sample Integration
checkbox is selected.

Setup Load Information

Loading information

Specify the type of load you want to perform. Enter Plate and OpenArray® Plate barcodes by
scanning them, typing them, or selecting the associated file.

Lse Sample Integration Sarmples Per Subarray 1 vl
Sample Plate | _ Plate Holder Position 1| ABC12 T

Plate Holder Position 2 | |

Plate Holder Position 3 | |
Plate Holder Pasition 4 | |

Select Samples to Load

Click the section on the sample plate frorm which the first sample will be extracted. The image on the
tight shows how the sample will be applied to the OpenArray Plates.

Plate Holder Position 1

ABCTZ

T

late Holder Position 2

(I —

late Holder Position 3

T -

late Holder Position 4
Sample section(s) already used: 1 on 2/1:2012

LTI

Net= | | cancel

3. Click Browse to the right of Sample Plate, then select the 384-well sample plate
*.csv file that was generated with the OpenArray™ Sample Tracker Software.

4. Click Browse to the right of the plate holder position corresponding to the

OpenArray™ of interest, then select the *.spf file corresponding to the desired
OpenArray™ plate.
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Set up the PCR reactions in an OpenArray™ 384-well Sample Plate

5. Click the corresponding 4 x 12 area of the 384-well plate, then click Next to open
the Setup Deck window.

6. Ensure that:

* Tip boxes are loaded in the AccuFill™ instrument in the displayed
configuration.

* Lids are removed from the tip boxes.

¢ The waste bin in the instrument is emptied.

7. In the Setup Deck window, select:
* The tips are configured as shown above
* The Waste Bin is empty

Set up the PCR reactions in an OpenArray 384-well Sample Plate

For best results, dilute DNA samples to 50 ng/pL before setting up the PCR reactions.

IMPORTANT! The 4 x 12 area(s) of the 384-well plate being filled must match the
area(s) designated in the OpenArray = Sample Tracker Software for that set of
samples.

1. Remove the OpenArray™ plate from the freezer; allow it to come to room
temperature in its unopened sleeve (~15 minutes).

The OpenArray™ plate must be completely thawed before transferring reactions
to it from the 384-well sample plate.

2. Mix the 2X Master Mix gently. Do not invert the bottle.
3. Vortex the Assay Working Stock, then centrifuge briefly.

4. Following the plate layout designated in the OpenArray ™ Sample Tracker
Software, add master mix, then UltraPure™ DNase/RNase-Free Distilled Water
(NTCs) or DNA samples, to an OpenArray ™ 384-well Sample Plate.

Note: Include 2 NTCs on each plate.

OpenArray" Genotyping Plate Format
Component
16 32 64 +
Taq Man® OpenArraym
Genotyping Master Mix 154k 204k 251k
One of the following:
e UltraPure™ DNase/RNase-
Free Distilled Water (NTCs) 1:5uL 2.0pL 2.5k
e DNA sample
Total reaction volume 3.0uL 4.0 L 5.0 uL
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Transfer reactions to the OpenArray™ plate [AccuFill™ instrument] |

5. Seal the plate with an aluminum foil seal, remove the foil flap, mark the edges of
the filled 4 x 12 area with a pen, then score the foil along those lines.

Do not remove the foil from the scored area at this time.
6. Centrifuge the plate at 1,000 rpm for 1 minute.

If you make a sample layout error:

e Before the AccuFill ' procedure — Repeat “Generate 384-well sample plate layouts
in the OpenArray "~ Sample Tracker Software” on page 46 with a corrected
sample.csv file.

e After the AccuFill " procedure — See “Recover from layout errors in the 384-well
sample plate” on page 80.

Transfer reactions to the OpenArray  plate (AccuFill” instrument)

Ensure that the OpenArray  plate is thoroughly thawed before starting this
procedure.

1. Prepare the items needed to seal the OpenArray™ plate (next section).

Note: The OpenArray™ plate must be sealed promptly after being loaded with
the reactions (this section).

a. Ensure that the QuantStudio™ 12K Flex OpenArray™ Plate Press 2.0 is ready.

b. Gather and remove from packaging an OpenArray™ lid, plug, syringe with

OpenArray ™ Immersion Fluid, and syringe tip.

c. Attach the syringe tip to the syringe and carefully push some of the fluid
through the tip to remove air bubbles, then lay the syringe aside.

2. Remove the OpenArray ™ plate from its sleeve and place it in the plate holder of
the AccuFill™ instrument.

Ensure that the bar code on the OpenArray™ plate is facing left and the serial
number is facing right.

3. Using forceps, peel the foil from the filled area of the OpenArray™ 384-well
Sample Plate.

4. Close the instrument door.

5. In the AccuFill"™ software Setup Deck window, select the following
confirmations, then click Load.

¢ The OpenArray Plate is in the Plate Holder
* Remove foil from the highlighted section of the Sample Plate

6. As soon as the Remove OpenArray Plate window appears, open the instrument

™

door, then remove the loaded OpenArray ™ plate.
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Seal the OpenArray™ plate
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7. Proceed immediately to seal the OpenArray™ plate (next section).

Note: For best results, seal the OpenArray™ plate within 90 seconds of
completion of loading, to prevent evaporation.

Seal the OpenArray  plate

IMPORTANT! Handle the OpenArray " plate and case only by the edges throughout
this procedure.

1. Place the filled OpenArray™ plate in the QuantStudio™ 12K Flex OpenArray™
Plate Press 2.0.

Ensure that the bar code is facing left and the serial number is facing right.

2. Remove the clear plastic sheets from the top and the bottom of the lid, remove
the red protective film around the edge of the OpenArray™ lid, then seat the lid
on the OpenArray ™ case in the plate press.

(@ Protective film (remove)

(2 Adhesive

(3 Protective film (remove)

(® Notched end (align with serial number)

3. Engage the press mechanism until the green flashing light changes to a steady
green light (~20 seconds).

4. Disengage the press, then remove the OpenArray™ case.
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Run the OpenArray™ platels] on the QuantStudio™ 12K Flex instrument 5

5. While holding the OpenArray™ case by the edges, insert the prepared syringe tip
into the port in the case, then carefully inject immersion fluid until the case is
filled.

Note: Minimize creation of air bubbles when you dispense the fluid; one small
air bubble in the case is acceptable.

The syringe tip must be in front of the array when filling the case with immersion fluid.

6. While holding the case vertically, remove the syringe tip, insert the screw end of
the OpenArray ™ plug into the port and rotate clockwise until the black handle
breaks off.

IMPORTANT! To avoid leaking of immersion fluid, hold the case vertically and
rotate the plug slowly.

7. Clean the case with a laboratory wipe that has been thoroughly sprayed with
ethanol, then dry the case with a clean laboratory wipe.

Run the OpenArray  plate(s) on the QuantStudio” 12K Flex
instrument

1. On the instrument touchscreen, touch  to extend the loading arm, and place
the OpenArray™ plates on the plate adapter.

Ensure that the plate barcode and serial number are facing the front of the
instrument.

2. Touch  to retract the loading arm.

3. Inthe ﬁ Home screen of the QuantStudio™ 12K Flex Software, select
Run » OpenArray.

™

4. In the Select Instrument pane, select your QuantStudio™ instrument.
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54| Check the QC Images

%,

20

5. Click Get Plate IDs to import the barcode(s) of the OpenArray™ plate(s).

Once the OpenArray™ serial numbers appear, the loaded *.spf files
corresponding to each plate should appear in the Setup File field.

If not, click Browse, then select the correct loaded *.spf file from the Loaded SPF
folder.

6. (Optional) Click Browse to change the QuantStudio™ Experiment File Location.
7. (Optional) Change the software-determined Experiment File Name.

8. Click Start Run.

Note: The instrument pauses at 41 or 42 seconds prior to the end of the run. Wait
for the system to complete the run before opening the *.eds file.

9. Transfer the *.eds file from the instrument to an accessible location for analysis in
TagMan® Genotyper Software.

Check the QC Images

Check the QC images before analysis in TaqMan® Genotyper Software. For additional
information, see TagMan® OpenArray” Genotyping Troubleshooting Guide
(Pub. No. MANO0011115).

1. In the QuantStudio™ 12K Flex Software {§  Export screen:
a. Click Browse to create a uniquely-named folder for the QC images export.

b. Click Export QC Images (bottom of screen).

IMPORTANT! Create a new folder for images each time; exporting a second run
to the same folder overwrites the images.

2. View the following ROX™ image to check for loading quality issues:
e POST-READ_CHANNEL_4.tiff

3. Check for leaks or other displaced sample issues.
a. View the following spotfinding images:
e 503_c001_t03_p0001_m2_x3_el_cp#_spotfind.tiff
* 504_c001_t02_p0001_m2_x3_el_cp#_spotfind.tiff

Note: The “cp#” in the image file name refers to the array position (1-4)
within the instrument.

b. If a problem is found, view the following pre-run spotfinding image to
determine if the issue existed even before cycling (this is useful for
troubleshooting):

e 500_c001_t01_p0001_m2_x3_el_cp#_spotfind.tiff
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One-time procedures

. View the following FAM™ and VIC™ images to check for any fluorescent

abnormalities and to confirm any problem seen in the spotfinding images:
e STAGE4_CYCLE1_CHANNEL_1.tiff
e STAGE4_CYCLE1_CHANNEL_2.tiff

. Note any abnormalities found, as well as all other potentially relevant

information related to the setup of the run.

One-time procedures

Set up default
folders and
software
preferences

This procedure simplifies the file locations used in the OpenArray  AccuFill"
instrument software.

Set up the default file locations and preferences before using the OpenArray
AccuFill” system for the first time. You must be logged in as an administrator.

. Create the following four folders in a convenient location on the same computer

drive as the AccuFill™ software:
* SPF Files
e Sample Tracker 96-well Input
¢ Sample Tracker 384-well CSV Files
¢ Loaded SPF Files

2. (Optional; not required if using the OA_Genotyping_CalcSheet) Navigate to

<drive>:\Program files (x86) \AppliedBiosystems\OpenArray
Sample Tracker\Examples, copy the 96-Well Sample Plate 1.csv file, then
paste it in the Sample Tracker 96-well Input folder.

. In OpenArray™ Sample Tracker Software, select View » Preferences, then enter

the following preferences:

Field Selection
Experiment type Genotyping
OpenArray” Plate Select the OpenArray " format that will be run most
often, for example, Genotyping - 64
Pipettor Fixed or Adjustable
Import Data Directory Sample Tracker 96-well Input folder
Export Data Directory Sample Tracker 384-well CSV Files folder

4. In the AccuFill™ software, select Instrument » Edit Preferences, then:

a. Select Require Sample Integration.
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2 Chapter 4 Prepare and run OpenArray™ PGx SNP genotyping experiments

b. Select the indicated folders.

For this AccuFill"
folder...

Select this folder...

Folder contents

OpenArray™ Plate
File Input Folder

SPF Files

*.spf files for your
OpenArray™ plates; contain
assay name and location

Sample Plate File
Folder

Sample Tracker 384-well
CSV Files

*.csv 384-well sample plate
layout files

Loaded OpenArray "
Plate File Folder

Loaded SPF Files

Integrated *.spf files that
are generated during
processing with the
AccuFill™ software.

™

5. In the QuantStudio™ 12K Flex instrument software, select
Tools » Preferences » OpenArray, then select the Loaded SPF Files folder for the

software Setup Folder.

Note: If the instrument software is not on same computer as the AccuFill

™

software, transfer the loaded *.spf files to the computer running the instrument

software.

Download SPF Files

Set up the optimized folder locations and software preferences before downloading
*.spf files. See “Set up default folders and software preferences” on page 53.

For custom OpenArray  plates, you need the Lot# and the Serial# from the packaging

of each OpenArray  plate.

1. At www.thermofisher.com/OA-platefiles, select TagMan® OpenArray” Custom

Gene Expression/Genotyping Plates in the Select Your Product dropdown list.

2. Select a download option:
¢ I want to download all available SPF & AIF files
¢ I want to download a specific SPF file

3. Enter the Lot# and the Serial#, then click Submit.
Note: The Serial# is case-sensitive.

4,

54

Save the *.spf files to the desktop SPF Files folder.

Note: Do not create sub-folders in the SPF Files folder. The software cannot
access sub-folders.
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This chapter contains brief procedures. For detailed procedures, refer to:

Title Pub. No.
QuantStudio™ 12K Flex Real-Time PCR System: 4470935
OpenArray  Experiments User Guide
OpenArray” Sample Tracker Software Quick Reference 4460657
OpenArray” AccuFill" System User Guide 4456986
OpenArray” SNP Genotyping Experiments MANO0014351
TaqMan® OpenArrayw Genotyping Troubleshooting Guide MANOO11115
TagMan® Genotyper Software Getting Started Guide 4448637
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| " Before you begin analysis [each time/

Before you begin analysis (each time)

Transfer files from
QuantStudio” 12K
Flex Software with
a network
connection

Transfer files from
QuantStudio” 12K
Flex Software
without a network
connection

56

™

. In the Home screen of the QuantStudio™ 12K Flex Software, click Instrument

Console.

™

. In the Instrument Console, select the desired QuantStudio™ 12K Flex Instrument

from the list of instruments on the network, then click Add to My Instruments.

™

. After the QuantStudio™ 12K Flex Instrument is added to your list, select it, then

click Manage Instrument.

. In the Instrument Manager, click Manage Files, then click File Manager.

. In the File Manager screen, transfer the file(s) from the QuantStudio™ 12K Flex

Instrument:

a. In the Folders field, select the folder that contains the files that you want to
download.

b. In the Experiments field, select the files to download. To select multiple files,
Ctrl-click or Shift-click files in the list.

c. When you have selected the files that you want to download, click
Download.

d. In the Send experiment to instrument dialog box, select the folder to which
you want to download the selected file(s), then click Open.

For more details on file transfers please refer to the networking chapter in the
QuantStudio” 12K Flex Real-Time PCR System Maintenance and Administration Guide
(Pub. No. 4470689).

Download and save files in one of the following ways:

¢ Connected computer

— Browse for the folder containing the run.

— Select run names and download the file to storage media.

¢ Instrument only

— Insert a USB storage device into one of the USB ports in the front panel.
— Use the touchscreen and press Collect Results.

— Select run names and press Save to USB.
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Analysis options for genotyping data

Analysis options for genotyping data

Analyze allelic discrimination plots for genotyping data using any of these tools:

Software Features
QuantStudio” 12K Flex  Desktop software
software * View real-time trace data to aid genotype calling
Thermo Fisher Cloud ¢ Cloud software
Genotyping Application * Create studies

e Overlay data from multiple plates
¢ View real-time trace data to aid genotype calling

TagMan® Genotyper  Desktop software
Software * Create studies

e Overlay data from multiple plates

Analyze data in QuantStudio” 12K Flex or Thermo Fisher Cloud
software

For non-standard assays, review the data for both assays together to ensure accurate
genotyping results.

™

To use the QuantStudio™ 12K Flex software or related instrument software:

1. In the analysis settings, select Analyze Real-Time Rn — Median (Rna to Rnb).
This setting will normalize for any run and system noise to improve data
accuracy.

2. Select Analysis » Allelic Discrimination Plot.

To use the Thermo Fisher Cloud GT Analysis module:

1. Go to thermofisher.com/cloud.

2. Create a project and import one or more OpenArray" experiment files (.eds).
3. Access the Genotyping (GT) application.

4. Analyze data.
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Analyze data with TagMan® Genotyper Software

Analyze data with TagMan® Genotyper Software

Before you begin
TagMan®
Genotyper
Software analysis

58

Create a study template

If using a reference panel, generate the reference panel before creating the study
template, so that the reference panel can be imported into the template.

If necessary, first download the Assay Information File (AIF) from http:/
www.thermofisher.com/OA-platefiles.

1. In the TagMan® Genotyper Software Home screen, click Create Study.

2. In the Workflow Menu pane, select Setup » Properties, then enter the study
properties.

* For Instrument Type, select QuantStudio™ 12K Flex Real-Time PCR
System.

¢ For Experiment Type, select Real-time.
3. In the Workflow Menu pane, select Setup » Assays.
4. Click Import, then select and import the Assay Information File (AIF).

5. (Optional) Import the reference panel:
a. In the Workflow Menu pane, select Setup » References.

b. Click Import, then select and import the reference panel file of interest.

6. Select File » Generate Template, enter a template name (.edt), then save the
template in the desired location.
(Optional) Generate a reference panel

A reference panel consists of high-quality data for all the assays in the study. The data
can be chosen from multiple OpenArray = plates.

For best results, generate a new reference panel for each lot of OpenArray  plates.

If necessary, first create a study containing data that will be used as reference samples.
For the study properties options, set QuantStudio™ 12K Flex Real-Time PCR System
for Instrument Type, and Real-time for Experiment Type.

1. In the TagMan® Genotyper Software, open the study that contains data points to
be used as reference samples.

2. In the Workflow Menu pane, select Analysis » Results.

3. Click-drag in the scatter plot to select one or more data points.

™ ™

Select data points for each homozygous genotype (FAM™ dye-labeled or VIC
dye-labeled) and the heterozygous genotype.

The non-selected data points will fade.
4. Right-click in the scatter plot, then select Tag for Ref Panel.

5. Repeat the selection and tag steps for additional data points.
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Analyze data with TagMan® Genotyper Software

Confirm that the correct samples have been tagged as reference samples in the
Results table.

In the Results tab, Reference Sample must be selected in the View dropdown
list to view the tags.

Repeat the data point selection, tagging, and confirmation steps for each SNP
assay of interest.

Select File » Save.

Select File » Generate Reference Panel, enter a name for the panel, then save the
file (.lap) to the desired location.

(Optional) Add samples to an existing reference panel

During analysis in TagMan® Genotyper Software, you can add samples to an existing
reference panel.

The reference panel must already be imported into the study containing samples that
will be added to the reference panel.

1.
2.
3.
Analyze results in 1.
TagMan®
Genotyper
Software
2.
3.
4.
5.

In the scatter plot of the study, select data points for the samples of interest, right-
click in the plot, then select Tag for Ref Panel.

Select File » Save.

Select File » Generate Reference Panel, enter a name for the panel, then save the
file (.lap) to the desired location.

In TagMan® Genotyper Software, click Create Study from Template, then select
and open the desired template (lat).

Note: If you have not created a template, see “Create a study template” on
page 58.

In the Workflow Menu pane, select Setup » Experiments.

Click Import, then select and import one or more OpenArray ™ experiment files
(.eds).

Click Analyze.

Inspect the call data for the SNP assay in the scatter plot.

Refer to the TagMan® Genotyper Software Getting Started Guide (Pub. No. 4448637)
for detailed instructions.

(Optional) To manually assign the genotype, select the sample(s), right-click, then
select the genotype.

Select Inspected next to the assay, then click Save.
Repeat the inspection for each SNP assay.

In the Workflow Menu pane, select Export » Analysis Data.
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R Analysis guidelines: sex chromosome targets

Review call rates
and other QC
parameters

10. In the Export Study Properties pane:
a. Select Analysis Results » Advanced.

b. Select One File.
c. Enter the filename and location, and select (*.txt).

11. Click Export preview, then click Start Export in the new window.

Select the appropriate tab to review call rates and other QC parameters in TagMan®
Genotyper Software.

To... Do this...
Review sample 1. Select Analysis » Quality Control.
call rates and QC

2. Select the Samples tab to review the sample call rates and
other QC parameters. Samples with low call rates are an
indication of poor sample quality or concentration and it is
advisable to omit those samples from the study.

data

3. (OptionalTo omit samples with poor quality or concentration,
right click the sample name, select Omit from the dropdown
menu, then reanalyze the data.

Review plate call | 1. Select Analysis » Quality Control.

rates and QC data 2. Review call rates and QC data in the Experiments tab.

Review assay call | 1. Select Analysis » Quality Control.

rates and QC data 2. Review call rates and QC data in the Assay tab.

For detailed instructions, see the TagMan® Genotyper Software Getting Started Guide
(Pub. No. 4448637).

Analysis guidelines: sex chromosome targets

60

In most cases, Use Hardy-Weinberg for Analysis is selected. X and Y chromosome-
specific SNP targets do not follow a Hardy-Weinberg distribution.

To improve the accuracy of genotype calls for SNP targets on the X and Y
chromosomes:

* Deselect Use Hardy-Weinberg for Analysis
* Select Disallow in Males from the Heterozygote drop-down list

Note: If you select Disallow in Males for other types of targets, the genotype call
accuracy may be negatively impacted.

SNP targets located in the PAR region of the X and Y chromosomes behave like
autosomal SNP targets and males can be heterozygotes. The gender assay
(C_990000001_10) target X— and Y- chromosome specific sequences in the amelogenin
gene: males run as heterozygotes and females run as VIC™ homozygotes. Do not
select Disallow in Males with these assay types.
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Analysis guidelines: DME genotyping assays for genes in copy
number variation regions

Some TagMan®” DME Assays target polymorphisms in genes that exhibit copy number
variation including CYP2D6, CYP2A6, CYP2E1, GSTM1, GSTT1, and SULT1A1. Copy
number variation analysis must be done in addition to genotyping with DME assays.
The frequency of the CYP2D6, CYP2A6, CYP2E1, and SULT1A1 gene deletions are
low, and samples that carry no copies of these genes will be rare. However, the
frequency of deletion of GSTM1 and GSTT1 genes is very high in a number of
populations and complete absence of these genes in individuals is common.

For a given DME assay that targets a gene that can be deleted or duplicated, the
following genotyping results are possible:

* If both copies of a gene are deleted in a sample (copy number of 0), samples will
not be amplified and will run with NTCs. If a sample running near the NTCs has
been called as undetermined, that call can be manually adjusted to "noamp”.

¢ If a sample contains 1, 2, or more than 2 copies of the gene and only one SNP
allele is present, the samples will cluster together in a homozygous allele.
Clusters will sometimes show some splitting: samples containing less target can
run closer to the NTCs than those containing more copies of the target.

¢ If a sample carries more than 2 copies of a gene and both SNP alleles are present,
it will fall within the heterozygous cluster or off to one side or the other of the
cluster (that is, the heterozygous cluster may exhibit some spreading). If a sample
close to the heterozygous cluster has been called as undetermined, manually
adjust the call to heterozygous.

Analysis guidelines: SNP genotyping assays for triallelic SNPs

Triallelic SNPs are interrogated using two TagMan® assays.
Example

e Assay 1: Major SNP allele (labeled with VIC™ dye) and first minor allele (labeled
with FAM " dye)

e Assay 2: Major SNP allele (labeled with VIC™ dye) and second minor allele
(labeled with FAM " dye).

Expected results

* Samples that are heterozygous for the detected SNP alleles will run as
heterozygous with the assay designed to that mutant allele.

* Samples running in or near a homozygous cluster can be a true homozygote for
the reported allele, or the sample can be a heterozygote for a reported allele and
for the unreported SNP allele of a given assay. Samples with one reported allele
in an assay can sometimes run together, or close to, those carrying two reported
homozygous alleles. If a sample close to a homozygous cluster is called as
undetermined, manually change the call to homozygous.

¢ Samples that are homozygous for the unreported SNP allele may cluster with
NTCs or may exhibit weak amplification due to probe nonspecific activity. If a
weakly amplifying sample is called as undetermined, manually adjust the call to
noamp'.
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(Optional) Export the TagMan® Genotyper Software results, then import the files into
AlleleTyper " Software for translation using a biallelic translation specific for the
triallelic SNP assay pair.

Manually determining genotype

If AlleleTyper  Software is not available, use the table below to manually determine
the sample genotypes. Note that the alleles reported by the ABCB1 SNP assays are
given in the (+) strand genome orientation whereas the ABCB1 gene maps to the (-)
genome strand. Thus, the reported SNP assay alleles and the SNP cDNA annotations
are the reverse complement of one another.

Table 15 Translation table for the ABCB1 ¢.3095G>T/A triallelic SNP rs2032582
assays

C/T assay C/A assay
Genotype
c.3095G>A, A893S ¢.3095G>T, A893T
ABCB1 ¢.3095G>T/A C_11711720D_40 C_11711720C_30
G/G C/C C/C
G/A C/T C/C
AJA T/T noamp
G/T c/C C/A
T/A T/T A/A
T/T noamp A/A
CIT
A/A, CIA
TIA
TIT
C/A, CIC CIT, CIC

Triallelic SNP rs2032582 assay results

Left: ABCB1 ¢.3095G>A assay (C_11711720D_40) to the plus strand C wild type and T mutant allele. Right: ABCB1 ¢.3095G>T
assay (C_11711720C_30] to the C wild type and A mutant allele.
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Analysis guidelines: DME genotyping assays for adjacent SNPs

Pairs of assays are available for some adjacent SNP targets for which only three

haplotypes are noted. For a given assay to one SNP allele:

* Samples that are heterozygous for the detected haplotypes will run as

heterozygous with the assay designed to that haplotype.

¢ Samples running in or near a homozygous cluster can be a true homozygote for
the reported haplotype, or the sample can be a heterozygote for a reported
haplotype and an unreported haplotype of a given assay. Samples having just one
reported haplotype may run together with, or close to, those carrying two
reported homozygous haplotypes. If a sample close to a homozygous cluster is
called as undetermined, manually change the call to homozygous.

* Samples that are homozygous for the unreported haplotype may cluster with
NTCs or may exhibit weak amplification due to probe nonspecific activity. If a
weakly amplifying sample is called as undetermined, manually adjust the call to

"noamp”.

Table 16 Translation table for the CYP2C19*2,*10 adjacent SNP assays

';Z'Llf;t’; ':Z/ Diplotypes!’! | *2 assay 681 G/A - 680C | *10 assay 681G - 680 C/T
— CYP2C19 C__25986767_70 C__30634128_10
G-C/G-C *1/*1 G/G c/C
G-C/G-T *1/%10 G/G C/T
G-C/A-C *1/%2 G/A c/C
G-T/G-T *10/*10 noamp /T
G-T/A-C *2/*10 A/A /T
A-C/A-C *2/*2 A/A noamp

[0 Since the *2 and *10 alleles have not been observed to occur on the same chromosome, diplotypes containing
A-T haplotypes are not included.
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*2/+2
*2/+2

Figure 2 CYP2C19*2 and *10 assay OpenArray" results

Left: rs4244285 CYP2C19*2 681G>A assay [ C__ 25986767_70) to the G wild type and A mutant allele. Right: rs6413438
CYP2C19*10 c.680C>T assay (C__30634128_10) to the C wild type and T mutant allele. Samples: Coriell gDNAs; NA17263 has
a *2/*2 diplotype that cannot be detected by the *10 assay.

Table 17 Translation table for the CYP2C9*3,*4 adjacent SNP assays

I;I-Iaal;ll‘):t);ll:)ee/ Diplotypest] *3 .’ass_e‘ll)({J ; 217-5 A/C *4 assay "Ir%SA - 1076
- CYP2C9 C__27104892_10 C__30634131_20
A-T/A-T *1/*1 A/A T/T
A-T/C-T *1/*3 A/C T/T
A-T/A-C *1/*4 A/A T/C
C-T/C-T *3/*3 c/C noamp
C-T/A-C *3/*4 c/C c/C
A-C/A-C *h[*4 noamp c/C

1 Since the *3 and *4 alleles have not been observed to occur on the same chromosome, diplotypes containing
A-A haplotypes are not included.
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*3/*3 *3[%3

Figure3 CYP2C9*3 and *4 assay OpenArray " results

Left: rs1057910 CYP2C9*3 c.1075A>C assay (C__27104892_10) to the A wild type and C mutant allele. Right: rs56165452
CYP2C9*4 c. 1076T>C assay (C__30634131_20] to the T wild type and C mutant allele. Samples: Coriell gDNAs; NA17247 has
a *3/*3 diplotype that cannot be detected by the *4 assay. Note that the *3 heterozygous samples run in the lower portion of
the split wild type FAM cluster in the *4 assay.

Related documentation

Title Pub. No.
TagMan® Genotyper Software Getting Started Guide 4448637
TagMan® OpenArray” Genotyping Troubleshooting Guide MANO0O011115
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Prepare, run, and analyze PGx copy

number experiments

Introduction to copy number analysis ................. ... ..o oo 67
How TagMan® Copy Number Assays work .............................. 67
Procedural guidelines ......... .. ... . 68
Beforeyoubegin .......... ... 68
Set up PCR 1€actions ... ........uuuuuuiiiiiiiiiiiiii i 68
Runthereactions ............... i 69
Analyze the run in the instrument software and export the results .......... 70
Analyze results in CopyCaller™ Software ............... ... .. ... .. .. 71
Review the copy number analysisdata ............................... ... 72

This chapter contains brief procedures. For detailed procedures, refer to:

Title Pub. No.
TagMan® Copy Number Assays Protocol 4397425
CYP2D6 Allele-specific Copy Number Analysis Quick MANO0011114
Reference
CopyCaller” Software v2.0 User Guide 4400042

Pharmacogenomics Experiments Application Guide




Chapter 6 Prepare, run, and analyze PGx copy number experiments  E&22
Introduction to copy number analysis

Introduction to copy number analysis

Copy number variation must be assessed for DME genes that are known to exhibit
copy number variation. For full details on running TagMan® Copy Number Assay
experiments, refer to the TagMan® Copy Number Assays Protocol (Pub. No. 4397425).
The protocol provides step-by-step instructions for performing and analyzing copy
number variation quantitation experiments using TagMan® Copy Number Assays and
TagMan® Copy Number Reference Assays for the ViiA™ 7 Real-Time PCR System. The
same instructions apply for running experiments on the QuantStudio™ 12K Flex Real-
Time PCR System.

How TaqMan® Copy Number Assays work

TagMan® Copy Number Assays are run simultaneously with a TagMan® Copy
Number Reference Assay in a duplex real-time PCR reaction. The TagMan® Copy
Number Assay detects the target gene or genomic sequence of interest, and the
TagMan® Copy Number Reference Assay detects a sequence that is known to exist in
two copies in a diploid genome (for example, the human RNase P H1 RNA gene).

The number of copies of the target sequence in each test sample is determined by
relative quantification (RQ) using the comparative CT (AAC;) method. This method
measures the C, difference (AC,) between target and reference sequences, then
compares the AC; values of test samples to a calibrator sample(s) known to have two
copies of the target sequence. The copy number of the target is calculated to be two
times the relative quantity, because the human genome is diploid.

In a copy number quantification reaction, purified genomic DNA is combined with:

™

e The TagMan® Copy Number Assay, containing two primers and a FAM
dye-labeled MGB probe to detect the genomic DNA target sequence.

e The TagMan® Copy Number Reference Assay, containing two primers and a
VIC™ dye-labeled TAMRA™ probe to detect the genomic DNA reference
sequence.

* One of the following master mixes:

- (Recommended) TagPath™ ProAmp™ Master Mix

- TagMan® Genotyping Master Mix

Reactions are run on an Applied Biosystems™ Real-Time PCR System. After
amplification, data files containing the sample replicate CT values for each reporter
dye can be exported from the real-time PCR instrument software and imported into a
software analysis tool. Applied Biosystems™ CopyCaller™ Software is recommended
for post-PCR data analysis of copy number quantification experiments.
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Procedural guidelines

* Use 10 ng of high-quality DNA per reaction.

* Run quadruplicate reactions for each DNA sample. The
OA_Genotyping_CalcSheet assumes quadruplicate reactions in 384-well plates.

¢ For quality metrics calculations, each plate should contain enough samples such
that there will be at least 7 samples with the same copy number.

¢ Include a no template control (NTC) reaction in each plate. In place of the DNA
sample, use the same diluent used to dilute the DNA.

* Include one or more samples of known copy number as controls (reference or
calibrator sample).

Before you begin

¢ Normalize the DNA samples: dilute each DNA sample to 5 ng/pL in nuclease-
free water or 1X TE buffer in a total of 10 pL.

Use the OA_Genotyping_CalcSheet to calculate the dilutions based on the
concentration determined from the RNase P assay.

¢ Generate the CNV Sample .txt file from the OA_Genotyping_CalcSheet.

Set up PCR reactions

1. Prepare the reagents:

a. Completely thaw the assays, gently vortex, then briefly centrifuge to bring
the contents to the bottom of the tube.

b. (Large-scale copy number assays (60X) only) Dilute the assay 1:3 (final
concentration 20X) with 1X TE, pH 8.0.

For example, combine 10 pL of 60X assay with 20 puL of TE.

c. Swirl the master mix to mix contents thoroughly.
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Run the reactions

Chapter 6 Prepare, run, and analyze PGx copy number experiments  E&22
Run the reactions

Prepare the reaction mix: combine the following components, invert or flick the
tube to mix, then centrifuge briefly to bring the contents to the bottom of tube.

a. Combine the components according to the table.

Note: We recommend using four replicates of each sample.

Component Vom:::c':ii:lm_"l'
TagPath™ ProAmp" Master Mix[?! 5.0 uL
TagMan® Copy Number Assay (20X) 0.5 L
TagMan® Copy Number Reference Assay (20X) 0.5 uL
Nuclease-free water 2.0 L
Total volume 8.0 uL

' Use the OA_Genotyping_CalcSheet to calculate volumes for multiple reactions.
12 TagMan® Genotyping Master Mix (2X] can also be used.

b. Invert or flick the tube to mix, then centrifuge briefly.

Transfer 8 uL of the reaction mix to the sample and control wells of a 384-well
reaction plate.

Vortex the normalized gDNA samples (5 ng/pL), add 2 pL of each sample or
control to the appropriate wells of the plate, then mix by pipetting up and down
several times.

Briefly centrifuge the plate to ensure the reaction mixes are at the bottom of each
well and to minimize air bubbles.

™

Seal the plate with MicroAmp™ Optical Adhesive Film, ensuring that all 4 edges
have a tight seal.

Create an experiment in the instrument software with these properties:

Property Setting
Experiment type Standard Curve
Reagents TaqMan® Reagents
Run speed Standard

In the Define screen, enter the Target name, then select the appropriate Reporter
and Quencher for the target.

Assay Reporter Quencher
TagMan® Copy Number FAM™ MGB-NFQ
Assay
TagMan® Copy Number vic™ TAMRA™
Reference Assay
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3. In the Assign screen:

¢ Import the CNV Sample .txt file generated from the
OA_Genotyping_CalcSheet, or manually assign sample names to the
appropriate wells.

* Assign both assays to each well.

4. In the Run Method screen:
* Set the reaction volume to 10 pL.

¢ Confirm the following thermal cycling parameters.

Stage Step Temperature Time
Hold Step 1 95°C 10 min
PCR Step 1 95°C 15 sec
(40 cycles) Step 2 60°C 60 sec

5. Save the experiment, load the sealed plate into the instrument, then start the run.

Analyze the run in the instrument software and export the results

1. In the Analysis tab of the experiment, click Analyze.

2. In the Amplification Plot for each target, deselect Auto Threshold, then set the
C; threshold to 0.2. Alternatively, use 0.1 as needed to ensure that the threshold is
in the middle of the log phase.

Keep Auto Baseline selected.

Amplification Plot

02
&
€ o
0014
K 7
Bk N =y
o001 AR R ¥ TR RINATNES N 01 1]
2 4 a a2 w0 1. " 1 A
Options
Target: Cyp2D6 exon 9 « [|Threshold: [T Auto (0.2 |¥] Auto Baselne
Show: [¥] Threshold — [] Baseline Start: Wel M Target 4. Baselne End: Wel |M Target & [

3. Click Analyze, then save the experiment.
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Analyze results in CopyCaller™ Software L

In the Export screen, ensure that the only Results is selected.

5. Select a location and file name, select *.txt in the File Type dropdown list, then

click Start Export.

Analyze results in CopyCaller  Software

The recommended settings in CopyCaller ' Software are described. See “CopyCaller”
Software analysis options” on page 71 for other analysis options.

1.

In the software, select File » Import, select the file that was exported from the
instrument software, then click Open.

In the Assay Selection Table, click row(s) to select one or more assays, then click
= (Analysis Settings).

. In the Analysis Settings window:

* Select With calibrator sample
¢ For Calibrator Sample: select Median C;

¢ For Calibrator sample copy number: enter 2

Note: Enter 1 for GSTT1 and GSTM1 assays.

Click Apply.
The data are analyzed using the selected analysis settings.

CopyCaller™

Analysis method Description How to select

Software analysis
options

Recommended:
Median C;

Select With Calibrator
Sample.

In the Calibrator Sample
Name drop-down list,
select Median C;

Copy number results are based | 1.
on the copy number of the
sample with the median C; or 2.
median C; value. This method
works well when most samples
have the same copy number.

Most frequent copy

Copy number results are based | 1. Select Without Calibrator

number on the assumption that most Sample.
samples have the same copy 2. Inthe Most Frequent
number.

Sample Copy Number
field, enter the expected
value (Usually 2. Enter 1
for GSTM1 & GSTT1).
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Analysis method Description How to select
Calibrator Copy number results are based | 1. Select With Calibrator
on the copy number designated Sample.
for one calibrator sample. 2. In the Calibrator Sample
Include a calibrator sample on Name drop-down list,
each plate. select or enter a sample

to use as the calibrator.

IMPORTANT! The calibrator 3. (Optional Change
should be of the same sample Calibrator Sample Copy
type as the test samples. Number (default = 2).

Review the copy number analysis data

1. In the Assay Selection Table, select the checkbox to the left of the analyzed assay
to display the copy number analysis data.

2. Review the copy number analysis data to confirm that it meets the following

criteria:

Criteria Viewing tool
Samples have comparable VIC™ C; values Well and Results tables
Standard deviation is low for replicates (<0.15) Results table
Calculated copy number values are close to integer Results table and Copy
values Number Plot
Confidence and |Z-scorel values are acceptable for the Results table

predicted copy number calls

Copy number of control samples is as expected Results table and Copy
Number Plot

Copy number variation frequency is within the expected Results table and Copy
range Number Plot

Samples cluster into well-defined, well-separated copy AC; plot
number groups

3. Review the quality metrics. |Z-scorel Status

For sample copy number calls
having confidence values >95%,
consider passing or failing the call 2.65>2z>1.75 Pass with caution
based on the | Z-scorel value as > 265 Fail
shown in the table. |Z-scorel is only
evaluated for high confidence samples.

Passing the default 95% confidence threshold and |Z-scorel of <1.75 is very
achievable for good quality samples having 1-3 copies and is more difficult to
achieve for lower quality samples carrying duplications or for higher copy
samples.

<1.75 Pass
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Review the copy number analysis data

Consider passing samples with calls of >3 copies that fall below the 95%
confidence level if:

¢ The calculated copy numbers are close to integer values, and

* The samples cluster with passing samples of the same copy number group
in the AC; plot.
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Perform translation analysis in
AlleleTyper" Software

B Introduction to AlleleTyper™ Software ............. .. ... .. ...o... 74
B PGxtranslationtables ........ ... ... .. . 75
B Sources of PGx translation information and example translation tables . ... .. 75

Introduction to AlleleTyper  Software

74

™

AlleleTyper™ Software is an automated data analysis application that translates
genetic pattern information from TagMan® SNP Genotyping Assay and/or TagMan®
Copy Number Assay results to user-defined genotype or diplotype nomenclature. For
complete instructions on how to use AlleleTyper™ Software and to create user-defined
translation tables, see the AlleleTyper™ Software User Guide (Pub. No. 4486002).

AlleleTyper™ Software is a flexible tool used for conversion of sample genotype
information for single or multiple genes or loci to the desired nomenclature, for
example, the PGx gene-level star (*) allele nomenclature to describe SNP, InDel or
copy number variant genotypes (for example, for the Cytochrome P450 genes). Star
alleles are haplotypes that can contain multiple variants; these are associated with
functional or nonfunctional gene products. AlleleTyper™ Software can translate the
genotype results for special cases including triallelic or adjacent SNP interrogation
using two TagMan® SNP Assays, or the software can simply provide a name for a
particular genetic outcome for a given SNP or copy number assay.

Before creating a translation table, or translator, consider all of the TagMan® SNP
Genotyping Assays (includes TagMan® DME Genotyping Assays) and TagMan® Copy
Number Assays that will be used in your project, and which of these you want to
include in a translation table for reporting sample genotype results using specific
nomenclature. SNP assay and copy number assay experiment data generated on an
Applied Biosystems™ real-time PCR system must be analyzed by TagMan® Genotyper

Software and CopyCaller™ Software, respectively, because results files exported from
these software systems are input files for AlleleTyper™ Software.

AlleleTyper™ Software aids creation of translation tables by automatically converting
monoallelic translation tables containing haplotype patterns to biallelic translators
containing diplotype or genotype patterns. After examining biallelic translators for
completeness and accuracy, they are imported into AlleleTyper™ Software along with
TagMan® Genotyper Software data files and/or CopyCaller™ Software data files.
AlleleTyper™ Software then matches the sample genetic pattern data to patterns in the
biallelic translator and reports back the designated nomenclature for each matching

pattern, on a gene-by-gene basis when a multigene translator is used.
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PGx translation tables

The translation tables provided by both Thermo Fisher Scientific and PharmGKB use
the convention whereby the variant alleles are provided in the (+) strand orientation
of the reference genome. Likewise, TagMan® SNP and DME Genotyping Assays
context sequences are provided in the (+) genome strand orientation. In contrast, the

* allele nomenclature for many PGx genes does not follow this convention; the variant
alleles might map to the (-) strand of the reference genome and thus are given in the
reverse complement orientation (for example, CYP2D6, which maps to the (-) genome
strand).

For successful translation of sample genotyping results by AlleleTyper™ Software, the
base alleles used in the translation table must match the base alleles used in the
TagMan® Genotyper Software results files. In addition, the assay identifiers must
match between the translation table and the TagMan® Genotyper Software and/or

™

CopyCaller™ Software results files.

Sources of PGx translation information and example translation

tables

Thermo Fisher Scientific provides example AlleleTyper  Software translation table
template files and translation tables (including monoallelic and biallelic tables; single
gene and multigene translators) for commonly tested drug metabolism gene variants.
These files can be downloaded from the AlleleTyper  Software web page at
www.thermofisher.com/pgx and used as templates for creating translators specific to
a TagMan® Assays panel.

The PharmGKB website (www.pharmgkb.org) provides comprehensive haplotype
translation tables for CYP gene variants found in the Human Cytochrome P450 (CYP)
Allele Nomenclature Database (www.cypalleles.ki.se) as well as for other drug
metabolism gene variants. These tables can be used as reference tables for creating
AlleleTyper  Software translation tables.
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Troubleshooting

WARNING! Read the Safety Data Sheets (SDSs) and follow the handling
instructions. Wear appropriate protective eyewear, clothing, and gloves. Safety
Data Sheets (SDSs) are available from thermofisher.com/support.

Troubleshoot with cycling and imaging run images

Many problems with OpenArray  results can be diagnosed by examining the quality
control (QC) images taken at various points during a cycling/imaging run.

The QC images are fluorescent or reflected light images taken before, during, and

after cycling. They may require adjustment to make image features visible. To view

the images, we recommend that you install the free software program Image]J, which

allows you to easily manipulate the images in ways that other image viewers cannot.
1. In the QuantStudio™ 12K Flex Software {§ Export screen:

a. Click Browse to select a uniquely-named folder for the QC images export.

b. Click Export QC Images (bottom of screen).

IMPORTANT! Select a new folder for images each time; exporting a second run
to the same folder overwrites the images.

2. Use Image] to view the images of interest.

To... View image... Image description
Confirm the identity of | BARCODE IMAGE.tiff Reflected light image of the entire
images within a folder OpenArraym plate
Evaluate the loading PRE-READ_CHANNEL_4.tiff Pre- and post-ROX™ images
quality POST-READ_CHANNEL_4.tiff
Check for existing sUO_cUO1_t0’|_pOOO1_m2_x3_e1_cp#_spotfind.tiff[” Pre-run reflected light spotfinding
contamination on the image (used by the software to
case and/or heated determine the location of the holes)
cover
Identify potential leaks |s03_c001_t03_p0001_m2_x3_e1_cp#_spotfind.tiff'! | Mid-run reflected light spotfinding
or other contamination image
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Appendix A Troubleshooting

AccuFill™ instrument plate loading errors

To... View image...

Image description

Identify potential leaks
or other contamination

s04_c001_t02_p0001_m2_x3_e1_cp#_spotfind.tiffl!]

Post-run reflected light spotfinding
image

Look at patterns in the
fluorescent data (for
example, gradients)

STAGEx_CYCLEy_CHANNEL_z.tiff

FAM™ (z=1) or VIC™ (z=2) images at a
particular cycle [y) of a particular
stage (x) of the run.

[ The “cp#” in the image file name refers to the array position (1-4) within the QuantStudio™ 12K Flex instrument.

3. (Optional) Adjust the images for brightness and/or contrast to make image

features visible.

a. Open the image in Image].

b. Select Image » Adjust Brightness/Contrast (or press Ctrl+Shift+C).

c. Click Auto or adjust the sliders until the features of interest in the image are

visible.

AccuFill” instrument plate loading errors

Observation

Possible cause

Recommended action

There are empty through-holes

Insufficient sample was
added to the 384-well sample
plate.

Use proper pipetting
techniques. Ensure that there
are no air bubbles in the
pipette tips after sample
aspiration.

Reaction mix (sample +
master mix) is not at the
bottom of the 384-well
sample plate.

Centrifuge the sample plate
at 1,000 rpm for 60 seconds.
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Appendix A Troubleshooting
AccuFill™ instrument plate loading errors

Observation

Possible cause

Recommended action

Turn-holes are repeatedly missed

AccuFill™ instrument is
aligned too far to the left or to
the right.

Systematic loading problems
can occur with the AccuFill"™
instrument, which indicates a
need for service. For example,
when turn-holes are
repeatedly missed across
multiple subarrays, service is
required. Turn-holes are
where the AccuFill™
instrument changes direction
during sample loading.

0,690 06,0
0/ 0]0 0)0/0]0®
0/ 0)0 0]0 00 @)
0/ 0)0 0]0 00 @)
0/ 0)0 0]0 00 @)
0/ 0)0 0]0 00 @)
0/ 0)0 0]0,0]0 @)
Q006000

@ Turn holes
O start points
@ Stop points

Contact your local field
service engineer.

Entire subarrays are missing

The sample/master mix not
added to particular wells in
the 384-well sample plate.

Visually inspect the sample
plate to ensure that the wells
have sample/master mix.

Stuck tip mandrel on
AccuFill™ instrument may
need cleaning.

Contact your local field
service engineer.

Pipette tip not loaded on
mandrel.

Contact your local field
service engineer for frequent
occurrences (infrequent
occurrences can be due to a
poorly molded tip).

78
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OpenArray™ plate assembly and handling errors

OpenArray  plate assembly and handling errors

Observation

Possible cause

Recommended action

Case leaks and bubbles inside the case

Improper sealing of theOpenArray™ plate in the
OpenArray™ Case can lead to immersion fluid
leaks or bubble formation inside the case, leading
to uneven heating and imaging throughout PCR
and to poor quality genotyping data.

The images above are examples of OpenArray™
plates that have been affected by immersion fluid
leaks. The images show where leaked fluid has
condensed on the underside of the heated cover
windows and obscured the view of the through-
holes.

The best image in which to detect leaks is the
s03_c001_t03_p0001_m2_x3_e1_cp#_spotfind.tiff
image. This image is taken at the start of cycling,
which is where most leaks occur. See
“Troubleshoot with cycling and imaging run
images” on page 76.

Plate press was not engaged
for at least 20 seconds.

Fully engage the plate press
for at least 20 seconds.

Damaged lid adhesive.

Remove the liner and visually
inspect the lid adhesives for
defects. Ensure that adhesive
is not damaged or warped.

Damaged fill port screw
gasket.

Visually inspect the screw to
ensure that the orange gasket
is present and not damaged.

Damaged fill port screw
assembly. Breaks off too
easily.

The screw may be mis-
threaded: Unscrew it and use
a new screw assembly.

Oily lid or case from
immersion fluid overflow.

Wipe off excess overflow of
immersion fluid from the lid,
case bottom, and crevices
with 70% isopropyl alcohol,
using a lint-free cloth (the
cloth included with the
OpenArray™ plate is
acceptable).

Immersion fluid exposed to
air for too long.

Do not remove the immersion
fluid syringe cap or draw air
bubbles into the syringe until
you are ready to load. Do not
draw air bubbles into the
syringe.

Too large of a bubble inside
the OpenArray™ case after
sealing.

Minimize the size of the
bubble by tilting the
OpenArray™ case so that the
fill port is at the highest point.
Slowly fill the case with
immersion fluid until only a
small air bubble remains.
Attach the screw and wipe off
any excess oil that may have
spilled onto the case.

Damaged plate press leading
to uneven pressure.

Contact your field service
engineer if you suspect that
your plate press may be
damaged.
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Appendix A Troubleshooting

Recover from layout errors in the 384-well sample plate

Observation

Possible cause

Recommended action

Sample blow out during the addition of immersion
fluid

The reactions in A12 were
compromised during the
addition of immersion fluid.
Injecting the immersion fluid
too quickly can actually purge
the sample out of the
through-holes near the fill
port. Often this is caused by
the user not purging the
syringe slightly before use.

Dispense a small amount of
immersion fluid onto a paper
towel before use to ensure
smooth operation of the
syringe.

Evaporation of reaction mixture in through-holes

Too much time elapsed before
plate was sealed with lid and
immersion fluid. In this
example, the top half of each
subarray was intentionally left
open to the environment to
demonstrate the effect of
evaporation. “Donuts” are a
result of the evaporated fluid
in the though-holes.

Add immersion fluid as soon
as the case is removed from
the plate press to minimize
the likelihood of evaporation,
then seal the case with the
lid.

Recover from layout errors in the 384-well sample plate

After the AccuFill" procedure, you can recover from plate layout errors that were
made during setup of the reactions in the 384-well sample plate. See the OpenArray "
Sample Tracker Software Quick Reference (Pub. No. 4460657) for additional information.

1. Create a corrected sample *.csv file.

2. Repeat “Generate 384-well sample plate layouts in the OpenArray™ Sample
Tracker Software” on page 46, but select OpenArray Plate X (for QuantStudio)
when exporting from the OpenArray ™ Sample Tracker Software.

3. Import the corrected *.csv file into the QuantStudio™ 12K Flex Software.

Note: You can import either before starting the run or after the run is complete.
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Appendix A Troubleshooting
Troubleshooting unexpected genotyping results

Troubleshooting unexpected genotyping results

The following table pertains to TagMan® SNP Genotyping Assays run on
OpenArray'systems. For a comprehensive guide to troubleshooting SNP assay
performance, refer to “Appendix A: Troubleshooting” in the TagMan® SNP Genotyping
Assays User Guide. (Pub. No. MAN0009593).

Observation

Possible cause

Recommended action

Diffuse clusters, loss of

amplification for many
samples in a dataset

Insufficient amount of

heterozygosity, and/or non- starting DNA and/or PCR

inhibitors present in the
sample preparation.

We recommend using 50 ng/pL starting DNA
concentration. If it is not possible to increase the
concentration of the starting material or remove
inhibitors from the sample preparation, preamplify the
sample. See the TagMan” OpenArray™ Genotyping
Sample Preamplification User Bulletin (Pub. No.
MANO0011116).

The images show poor quality SNP data (top) that is
improved by preamplifying the samples (bottom).
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Appendix A Troubleshooting
Troubleshooting unexpected genotyping results

Observation

Possible cause

Recommended action

Amplification plot is missing
expected cluster

Signal saturation caused
software to call homozygous
alleles as heterozygous (or
vice versa).

Use real-time traces to manually call alleles. See
“Recommended: Run OpenArray™ SNP genotyping
experiments in real-time mode” on page 44 for more
information.

Incorrect genotype called

Real-time traces were not
used to identify outlier data
points.

Use real-time traces to identify outlier data points and to
manually call alleles.

Real-time traces can be viewed in the QuantStudio™ 12K
Flex Software or the Thermo Fisher Cloud Genotyping
Module, which is accessed from thermofisher.com/cloud.

See “Recommended: Run OpenArray™ SNP genotyping
experiments in real-time mode” on page 44 for more
information.
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(Optional) Rerun
samples that fail
to cluster

Appendix A Troubleshooting
Troubleshooting genotype calls for assays with merging clusters

If a sample fails to cluster well with other samples or fails to amplify properly with
one or more assays (that is, there are UND and NOAMP calls in the run), rerun such
samples using single tube DME assays on 96-well or 384-well plates. We recommend
running control gDNA samples along with the unknown samples or use a reference
panel (see “(Optional) Generate a reference panel” on page 58). The controls will help
to provide more accurate genotype calling of the unknown samples.

Troubleshooting genotype calls for assays with merging clusters

Pharmacogenomics Experiments Application Guide

It can be difficult for the secondary analysis software (for example, TaqMan®
Genotyper Software) to make distinct genotype calls for assays with merging clusters
(see example below). In these cases, use the real-time traces from the QuantStudio
12K Flex Software to review the data by assay and manually call data as necessary.
Manually adjust the end-point cycle number to an earlier cycle using the Reveal
Traces scroll bar; the clusters will have a greater degree of separation. Use this
adjustment if any real-time traces do not show a smooth progression in signal
throughout the run.
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Options

To manually adjust the the end-point cycle number:

1. Open the experiment.

2. Select Analysis » Allelic Discrimination Plot from the Experiment Menu pane
on the left.

3. Select the Options icon (circled in red).
4. Select Reveal traces.

5. Use the slider to adjust the end-point cycle number and optimize allele
discrimination between genotype clusters.

6. Click Analyze to update genotype calls.
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Appendix A Troubleshooting
Expected versus unexpected noamp and undetermined calls

7. Save the run. Take note of the cycle number for each assay that has been

adjusted. These numbers can later be entered into the TagMan® Genotyper
Software.

Note: A lower call cycle presently does not transfer to the TagMan® Genotyper
Software. The software will re-set the cycle number to 50 cycles. Set up a separate
study with the lower cycle number.

. (Optional) Select Analysis » QC Summary from the Experiment Menu pane to

view the QC flags for the run.

Click each flag to display its meaning, and a troubleshooting link appears in the
right-side pane.

Note: Ignore the CTFAIL flag for genotyping data. Some samples do not have
both alleles present. This flag displays the amplification curve from the absent
allele does not meet quality metrics, but the amplification will be poor if an allele
is absent.

Expected versus unexpected noamp and undetermined calls

TagMan® Drug
Metabolism
Genotyping Assays
for genes in copy
number variation
regions
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For certain assays, it is expected that there will be some samples that legitimately fail
to amplify or have an undetermined genotype call. These include samples run with
assays that interrogate gene variants that are associated with copy number variation
and with assays that detect triallelic SNPs or adjacent SNPs. See “Analysis guidelines:
DME genotyping assays for genes in copy number variation regions” on page 61 and
“Analysis guidelines: SNP genotyping assays for triallelic SNPs“ on page 61 for details
on how to analyze the data for such assays.

Some TagMan® Drug Metabolism Genotyping Assays target polymorphisms in genes
that exhibit copy number variation. Copy number variation analysis must be done in
addition to genotyping with DME assays.

* If both copies of a gene are deleted in a sample (copy number of 0), samples will

not be amplified and will run near or with the NTCs.

If a sample contains more than 2 copies of a gene and both SNP alleles are
present, it will fall within the heterozygous cluster or occasionally to one side or
the other of it, in which case it may be called as undetermined. These should be
manually called as heterozygous for data analysis purposes.
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Appendix A Troubleshooting
Expected versus unexpected noamp and undetermined calls

Taq Man® Drug Triallelic SNP and adjacent SNP targets can be interrogated using a pair of Custom
Metabolism TagMan® SNP Genotyping Assays. Each assay contains one probe for the major SNP
Genotyping Assays allele or haplotype and one probe for one of the minor alleles or haplotypes. After

. : running paired assays in separate reactions on the same genomic DNA samples,
for triallelic SNPs

. compare the results of the two assays to determine the sample genotype. For a given
and adjacent SNP  asqay it is expected that:

targets ¢ Samples containing one reported allele may run close to or within a homozygous

cluster. Any samples running close to homozygous clusters that are called as
undetermined should be manually called as homozygous for data analysis
purposes.

* Samples that are homozygous for the unreported allele may cluster with NTCs or
may exhibit weak amplification due to probe nonspecific activity. If a weakly
amplifying sample is called as undetermined, manually adjust the call to
"noamp".
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Preamplification of low-
concentration gDNA

Preamplification in OpenArray™ experiments helps to ensure sufficient template
copies in the 33-nL qPCR reaction. At low template copy numbers, stochastic effects
can dominate the reaction because the random events at each template molecule
represent a large portion of the potential extension events. Stochastic events in qPCR
reactions are generally dominant at levels of <10 template copies and negligible at
levels of >100 template copies.

The standard OpenArray™ protocol for human SNP assays recommends starting with
50 ng/uL of genomic DNA. When diluted 50% in master mix and loaded into a

33-nL reaction chamber, the final template amount is 825 pg. This converts to

250 genomic copies (125 genomic copies for each allele in a heterozygote).

Preamplification can also be used to dilute PCR inhibitors from sample preparations
that are of sufficient DNA concentration but contain impurities, and therefore do not
amplify well with the TagMan® OpenArray™ Genotyping Master Mix.

This protocol describes targeted multiplex preamplification of 1 to 256 SNP loci
located in human genomic DNA samples. A multiplex pool of TagMan® SNP
Genotyping Assays is used to simultaneously preamplify up to 256 target
polymorphisms in a single reaction using a reduced amount of input DNA sample.

The preamplification product can be used as the sample template input for SNP
genotyping reactions with any of the individual TagMan® SNP Genotyping Assays
included in the multiplex preamplification assay pool. Perform genotyping
experiments using the individual TagMan® SNP Genotyping Assays following the
standard protocol except substituting preamplified product for genomic DNA
sample. It is not necessary to quantify or normalize preamplified product. The
preamplified sample can be added directly into the reaction plate or further diluted in
1X TE Buffer to the desired concentration.

For specific applications, a custom OpenArray™ Preamp Pool specific for your
TagMan® SNP assay panel can be ordered along with your OpenArray™ plate (contact
your sales representative for details).

Note: The protocol is compatible with TagMan® SNP Genotyping Assays, but is not
recommended for use with TagMan® Copy Number Assays.
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Appendix B Preamplification of low-concentration gDNA
Guidelines for starting DNA sample concentration

Guidelines for starting DNA sample concentration

DNA sample concentration Preamplification

Recommendation

<0.4 ng/pL Not recommended

Preamplification of DNA at concentrations <0.4 ng/uL is
not recommended, due to the potential for stochastic
events arising from low target number in the early rounds
of the preamplification and gPCR reactions.

0.4 ng/pL to 4.0 ng/uL Ideal preamplification

range

The preamplification protocol was developed using
genomic DNA samples within a starting concentration
range of 0.4 ng/pL to 4.0 ng/pL and a total of 0.5 ng to
5ngin the preamplification reaction.

Optimal performance will be achieved if the starting
concentration of genomic DNA samples is near the
middle of the working range (2.5 ng/pL). Our
recommended protocol for accurate quantification of
human gDNA samples using the RNase P Detection
Reagents Kit can be found in Appendix B of the
Pharmacogenomics Experiments User Guide.

4 ng/ulL to 25 ng/pL User discretion

Samples at these concentrations may be preamplified
without dilution, but these are out of the optimal range.

>25 ng/uL Not recommended

Samples with DNA sample concentrations >25 ng/uL do
not require preamplification. If samples at these
concentrations do not amplify well with SNP assays, they
likely contain PCR inhibitors. If this is the case, high
concentration DNA samples may yield good results after
dilution, and preamplification of these samples may be
unnecessary.

Note: 1 ng of human genomic DNA =300 genomic copies or 150 copies of each allele

in a heterozygote.

Required materials

Unless otherwise indicated, all materials are available through thermofisher.com.
MLS: Fisher Scientific (fisherscientific.com) or other major laboratory supplier.

Reagent Cat. No.
TagMan® PreAmp Master Mix 4391128
OpenArray™ PreAmp Pool 4485255!1]

Genomic DNA Samples

Supplied by user

1X TE Buffer, pH 8.0

12090015

Nuclease-free water

MLS

1 Cannot be ordered online. For information on ordering an OpenArray™ Preamp Pool, contact your sales

representative.
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Appendix B Preamplification of low-concentration gDNA

Perform the preamplification

Perform the preamplification

1. Prepare the individual preamplification reactions as shown in the following

table.

Note: Itis convenient to use plates with well volumes that can accommodate a
20X larger volume than the reaction for the 20-fold dilution step after

preamplification.

Note: TagMan® PreAmp Master Mix and OpenArray™ PreAmp Pool can be
prepared as a single reaction mix and distributed to the plate in 3.75-pL aliquots.
These volumes can be increased 2-fold if more preamplified product is needed.

Component Stock concentration A . Volume
concentration
TagMan® PreAmp 2X 1X 2.5 L
Master Mix
OpenArray” PreAmp 4X (0.20X each 1X (0.05X each 1.25 pL
Pool assay) assay)
Genomic DNA Sample | 0.4 ng/pL to 4 ng/uL 0.1 ng/pL to 1.25 L
1 ng/pL
(versus
150-1500 copies
per uL)
Total —_ —_ 5.0 uL

2. Firmly seal the reaction plate with a MicroAmp™ Clear Adhesive Film.

3. Vortex the reaction plate for 10 seconds and centrifuge briefly.

cycling conditions.

™

4. Run the preamplification cycling program on a GeneAmp™ PCR System 9700
(silver or gold block) or Veriti™ Thermal Cycler using the following thermal

Stage Step Temp Time
Hold Activate 95°C 10 min
Cycling (10 Denature 95°C 15 sec
toT4 cycles] Anneal/Extend 60°C 4 min
Hold Inactivate 99.9°C 10 min
Hold — 4°C up to 1 h or overnight

5. Transfer the reaction plate from the thermal cycler to a container with ice. Keep
the plate on ice until you are ready to dilute the preamplified product.
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Appendix B Preamplification of low-concentration gDNA
Dilute and store the preamplified product

Dilute and store the preamplified product
1. Centrifuge the reaction plate briefly prior to removing the film.

2. Remove the film, then add 95 pL of 1X TE Buffer to each well containing a
preamplified product, to create a 1:20 dilution.

3. Seal the reaction plate with a new MicroAmp™ Clear Adhesive Film.

4. Vortex the reaction plate for 10 seconds and centrifuge briefly.

5. Store the preamplified product at —25°C to -15°C.
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RNase P quantification for
genotyping experiments

In this procedure, the quantification method uses TagMan® Control Genomic DNA
(human) as a calibrator instead of a standard curve. The OA_Genotyping_CalcSheet
calculates the concentration of test DNA samples with this calibrator method.

Note: The OA_Genotyping_CalcSheet assumes duplicate RNase P reactions in a 384-
well plate layout.

Download the OA_Genotyping_CalcSheet from thermofisher.com/oaqrc.

Required materials

Unless otherwise indicated, all materials are available through thermofisher.com.
MLS: Fisher Scientific (fisherscientific.com) or other major laboratory supplier.

Item Source

TaqMan® Copy Number Reference Assay, human, RNase P 4403326

(20X)
TaqMan® Control Genomic DNA (human; ready for use) 4312660
TaqPath™ ProAmp™ Master Mix!"] 4371357

01 Any TagqMan® Master Mix, including the TagMan® Genotyping Master Mix can be used, but ensure that the run
mode on the instrument is appropriate for the master mix.

Before you begin

¢ Dilute test DNA samples 1:10 in Nuclease-Free Water.

* Determine the total number of reactions required by including;:
— Diluted test DNA samples
— Calibrator DNA sample

— No template control (NTC) reactions; use Nuclease-Free Water in place of
DNA sample

Note: We recommend a minimum of two reactions for each sample. The
OA_Genotyping_CalcSheet is set up for duplicate reactions.

* Generate the RNase P Sample .txt file from the OA_Genotyping_CalcSheet.
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Appendix C RNase P quantification for genotyping experiments
Set up and run the PCR, then quantify the DNA

Set up and run the PCR, then quantify the DNA

1.

10.

Prepare a reaction mix for the required number of reactions plus 10% overage.

Component Volume per reaction!"
TagPath™ ProAmp™ Master Mix SpuL
TagMan® RNase P Assay (20X) 0.5 L
Nuclease-free Water 2.5uL
Total 8 uL

[ See the OA_Genotyping_CalcSheet to calculate volumes for multiple reactions.

Transfer 8 uL of the reaction mix to the wells of a 384-well PCR reaction plate.

Add 2 pL of sample DNA, control DNA, or Nuclease-Free Water to the
appropriate wells.

Seal the plate with optical film.

Set up the real-time instrument with the following settings:
e Experiment type: Standard Curve
* Mode: Standard
e Reporter: VIC™
e Quencher: TAMRA™

e DPassive reference: included

To assign the sample names, import the RNase P Sample .txt file generated from
the OA_Genotyping_CalcSheet.

Load the plate, then start the run.

After the run is complete, deselect all but the Results tab, select a file location,
then export the results.

Remove duplicate sample IDs from the exported data by opening the exported
data file in Excel™, then:

a. Copy-paste sample names and their corresponding C; mean values into a
new sheet.

b. Select both columns and use the Remove Duplicates function.

Calculate the concentration of test DNA samples:

a. Copy- paste the Sample Names and Mean C; values into the
OA_Genotyping_CalcSheet.

b. Enter the dilution factor of the test DNA samples into the
OA_Genotyping_CalcSheet.
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Expected performance and system
specifications

See the QuantStudio " 12K Flex System Product Bulletin (Pub. No. CO23802) for more
detail on performance and specifications.

Table 18 Specifications for the QuantStudio™ 12K Flex OpenArray” AccuFill™ System

Description Specification
Fill rate 99.25%
Maximum allowable sample carryover <1%
Maximum allowable assay carryover <1%
Maximum number of through hole data points lost due to <5%
evaporation

Table 19 Specifications for QuantStudio™ 12K Flex TagMan® OpenArray™ Genotyping

Plates

Description Specification
Assay conversion rate from a 7900HT Real-Time PCR system >95%!1]
Concordance with assays run on a 7900HT Real-Time PCR 99.7%[M
system
Call rate 95%!1
Number of haploid copies of gDNA/through-hole 250
TagMan® OpenArray™ Genotyping Plate capacity per 8 hour day 12
by a single person
Time from purified DNA to genotyping data ~5 hours
Throughput of one technician in one day 110,000

1 Individual performance is dependent on the integrity and purity of samples.
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Overview

Controls for genotyping and copy
number experiments

Laboratories can verify the performance of selected TagMan® SNP Genotyping Assays
and TagMan® Drug Metabolism Genotyping Assays on OpenArray" plates by using
samples that represent all three genotypes (homozygous major allele, homozygous
minor allele, and heterozygous) to test for both amplification and cluster separation.
A laboratory may prefer to use samples that represent at least two genotypes
(homozygous major and minor alleles, or homozygous major allele and heterozygous)
to test that both assay probes function. Ideally, gDNA samples of known genotypes
are used for such experiments. However, for rare DME variants that are not
well-represented in populations, it may be necessary to use synthetic templates.

This Appendix includes information on sources of control cell line sample DNAs for
DME and SNP genotyping assays, as well as for copy number assays. It also includes
information on ordering synthetic template DNAs in plasmids.

Sources of reference materials

TagMan® Drug
Metabolism
Genotyping Assays
test data

This section describes some publicly available sources for reference or control
materials that can be used in genetic testing and assay performance experiments.

All TagMan® Drug Metabolism Genotyping Assays were run on 180 unique DNA
samples from four different populations in assay performance and reproducibility
testing. Samples tested included a panel of 45 African American and 45 Caucasian
samples obtained from the Coriell Cell Repositories and a panel of 45 Japanese and 45
Chinese samples provided by a collaborator. The minor allele frequencies determined
for each assay are provided at thermofisher.com (assay search results) and in the
DME Index.

Note: Many of the polymorphisms interrogated by this assay collection have very
low minor allele frequencies (MAFs) of less than 1%; thus, the minor allele was not
detected for all assays within the 180 test samples.

For TagMan® Drug Metabolism Genotyping Assays having a reported Applied
Biosystems™ MAF in the African American or Caucasian populations, heterozygous
or minor allele homozygous samples may be used as reference or control samples in
genetic testing and assay performance studies. A complete list of the samples used
and their genotypes is available at thermofisher.com.
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Appendix E Controls for genotyping and copy number experiments
Sources of reference materials

NCBI dbSNP
genotype data

Centers for
Disease Control
and Prevention
(CDC) reference
materials

TagMan® Copy
Number Assays
for DME genes

94

Order the gDNA samples from the Coriell Cell Repositories at http://ccr.coriell.org.
Please note that the genotypes of these samples were, for the most part, not verified
by sequence analysis.

Another source of DME assay control samples is the refSNP submissions in the NCBI
database of Short Genetic Variations (dbSNP) at www.ncbi.nlm.nih.gov/SNP.

Search the database by rs ID to navigate to specific refSNP pages that may have
genotype information for variants of interest, noted in the Allele summary box or the
Population Diversity table. Cell line gDNA samples are available from the Coriell
Institute biorepositories (https://catalog.coriell.org) for samples sequenced in the 1000
Genomes project or genotyped in the International HapMap project.

* 1000g controls: if the Allele summary box contains MAF/MinorAlleleCount
information from the 1000 Genomes project, navigate to the 1000 Genomes
browser (www.ncbi.nlm.nih.gov/variation/tools/1000genomes) and search by rs
ID. This will return a genotype results table for the SNP and neighboring SNPs
for all 2500 samples used in the project, grouped by population. Expand a
population to view individual samples and their genotypes

* HapMap controls: if the Population Diversity table contains genotype
information from the HapMap project, the sample genotypes can be found by
clicking on the submission ss # to navigate to the submission details page. For
HapMap samples, the sample genotypes can also be found at the HapMap web
site (http://hapmap.ncbi.nlm.nih.gov). A subset of the HapMap samples were
sequenced by the 1000g project.

Clinical Laboratory Improvement Amendments (CLIA)
wwwn.cdc.gov/clia/Resources/GETRM/default.aspx

The Centers for Disease Control and Prevention (CDC) provides genetic information
on cell line DNAs that can be used as reference materials for genetic testing and assay
validation. Some of these cell lines were characterized by the Genetic Testing
Reference Materials Coordination Program (GeT-RM). One major focus category is the
'Genetic Inherited Disease & Pharmacogenetics’ section. Download tables of reference
samples that contain PGx/DME or disease allele variants, many of which have been
confirmed by multiple labs and genetic testing technologies, can be downloaded
from:wwwn.cdc.gov/clia/Resources/ GETRM/MaterialsAvailability.aspx

Several DME genes occur in CNV regions (see “DME genes and copy number
variation” on page 15). In addition, the CYP2D6 and CYP2A6 genes are known to
recombine with related pseudogene sequences to generate hybrid genes, many of
which have decreased or null gene activity. TagMan® Copy Number Assays can be
used to detect deletions, duplications, and hybrid gene alleles. TagMan® Copy
Number Assays for the major known DME genes that exhibit CNV have been pre-
tested on a panel of 45 each African American and Caucasian (the same samples as
were used for TagMan® Drug Metabolism Genotyping Assay validation studies). A
complete list of the samples used and their genotypes is available at
www.thermofisher.com/pgx.

The gDNA samples can be ordered from the Coriell Cell Repositories website (http://
ccr.coriell.org).

Pharmacogenomics Experiments Application Guide


http://ccr.coriell.org
http://www.ncbi.nlm.nih.gov/SNP
https://catalog.coriell.org
http://www.ncbi.nlm.nih.gov/variation/tools/1000genomes/
http://hapmap.ncbi.nlm.nih.gov
http://wwwn.cdc.gov/clia/Resources/GETRM/default.aspx
http://wwwn.cdc.gov/clia/Resources/GETRM/MaterialsAvailability.aspx
http://www.thermofisher.com/pgx
http://ccr.coriell.org
http://ccr.coriell.org

Appendix E Controls for genotyping and copy number experiments
Plasmid controls

Plasmid controls

We have successfully used synthetic major and minor allele template DNAs cloned
into plasmids to test the performance of over 300 TagMan® DME Assays. In addition
to major or minor allele sequences, plasmids carry the RNase P RPPH1 gene for
accurate quantitation of plasmids by the standard curve analysis before use in
genotyping experiments. Equal quantities of major and minor allele plasmids are
mixed together to create heterozygous controls. Use the homozygous and
heterozygous plasmid controls to demonstrate amplification and detection of all three
genotypes by a given assay. Plasmid control samples will often, but not always,
cluster with gDNA samples. Review example data in the TagMan® Drug Metabolism
Genotyping Assays on OpenArray " Plates .ppt file from: www.thermofisher.com/

pgx.

For information on ordering TagMan® DME and SNP Genotyping Assay plasmid
controls, email QuantStudioFrontDesk@lifetech.com.
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Good PCR practice

Prevent contamination and non-specific amplification

PCR assays require special laboratory practices to avoid false positive amplifications.
The high throughput and repetition of these assays can lead to amplification of one
DNA molecule.

PCR good laboratory practices

When preparing samples for PCR amplification:
¢ Use a positive-displacement pipette or aerosol-resistant pipette tips.
* Follow proper pipette-dispensing techniques to prevent aerosols.

* Wear clean gloves and a clean lab coat (not previously worn while handling
amplified PCR products or used during sample preparation).

¢ Change gloves whenever you suspect that they are contaminated.
* Maintain separate areas and dedicated equipment and supplies for:
— Sample preparation
— PCR setup
— PCR amplification
— Analysis of PCR products
¢ Do not bring amplified PCR products into the PCR setup area.

* Open and close all sample tubes carefully. Centrifuge tubes before opening.
Avoid splashing or spraying PCR samples.

* Keep reactions and components capped as much as possible.

* Clean lab benches and equipment periodically with 10% bleach solution. Use
DNAZap™ PCR DNA Degradation Solutions Cat. No. AM9890).
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Safety

WARNING! GENERAL SAFETY. Using this product in a manner not specified
in the user documentation may result in personal injury or damage to the
instrument or device. Ensure that anyone using this product has received
instructions in general safety practices for laboratories and the safety
information provided in this document.

- Before using an instrument or device, read and understand the safety
information provided in the user documentation provided by the
manufacturer of the instrument or device.

- Before handling chemicals, read and understand all applicable Safety Data
Sheets (SDSs) and use appropriate personal protective equipment (gloves,
gowns, eye protection, etc). To obtain SDSs, see the “Documentation and
Support” section in this document.
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Appendix G Safety
Chemical safety

Chemical safety

WARNING! GENERAL CHEMICAL HANDLING. To minimize hazards,
ensure laboratory personnel read and practice the general safety guidelines for
chemical usage, storage, and waste provided below. Consult the relevant SDS
for specific precautions and instructions:

- Read and understand the Safety Data Sheets (SDSs) provided by the
chemical manufacturer before you store, handle, or work with any chemicals
or hazardous materials. To obtain SDSs, see the “Documentation and
Support” section in this document.

- Minimize contact with chemicals. Wear appropriate personal protective
equipment when handling chemicals (for example, safety glasses, gloves, or
protective clothing).

- Minimize the inhalation of chemicals. Do not leave chemical containers open.
Use only with adequate ventilation (for example, fume hood).

- Check regularly for chemical leaks or spills. If a leak or spill occurs, follow
the manufacturer's cleanup procedures as recommended in the SDS.

- Handle chemical wastes in a fume hood.

- Ensure use of primary and secondary waste containers. (A primary waste
container holds the immediate waste. A secondary container contains spills
or leaks from the primary container. Both containers must be compatible
with the waste material and meet federal, state, and local requirements for
container storage.)

- After emptying a waste container, seal it with the cap provided.

- Characterize (by analysis if necessary) the waste generated by the particular
applications, reagents, and substrates used in your laboratory.

- Ensure that the waste is stored, transferred, transported, and disposed of
according to all local, state/provincial, and/or national regulations.

- IMPORTANT! Radioactive or biohazardous materials may require special
handling, and disposal limitations may apply.
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Appendix G Safety
Biological hazard safety

Biological hazard safety

WARNING! BIOHAZARD. Biological samples such as tissues, body fluids,
infectious agents, and blood of humans and other animals have the potential to
transmit infectious diseases. Conduct all work in properly equipped facilities
with the appropriate safety equipment (for example, physical containment
devices). Safety equipment can also include items for personal protection, such
as gloves, coats, gowns, shoe covers, boots, respirators, face shields, safety
glasses, or goggles. Individuals should be trained according to applicable
regulatory and company/ institution requirements before working with
potentially biohazardous materials. Follow all applicable local, state/provincial,
and/or national regulations. The following references provide general
guidelines when handling biological samples in laboratory environment.

. U.S. Department of Health and Human Services, Biosafety in Microbiological
and Biomedical Laboratories (BMBL), 5th Edition, HHS Publication No. (CDC)
21-1112, Revised December 2009; found at:
www.cdc.gov/biosafety/publications/bmbl5/BMBL.pdf

- World Health Organization, Laboratory Biosafety Manual, 3rd Edition,
WHO/CDS/CSR/LYO/2004.11; found at:

www.who.int/csr/resources/publications/biosafety/Biosafety7.pdf
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Documentation and support

Related documentation
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Document Pub. No.
Thermo Scientific” KingFisher" Flex User Manual N07669
MagMAX" DNA Multi-Sample Ultra Kit MagMAX" 4428202
Express-96 Magnetic Particle Processor Protocol
Best Practices for Collection of Buccal Swabs for MANO0014348
Genotyping Experiments
Isolation of DNA for Genotyping Experiments MANO0014561
OpenArray” Sample Tracker Software Quick Reference 4460657
OpenArray” SNP Genotyping Experiments MANO0014351
OpenArray" Genotyping Analysis MANO0014352
TagMan®OpenArray” Genotyping Troubleshooting Guide MANOO11115
TagMan® Genotyper Software Getting Started Guide 4448637
TagMan® SNP Genotyping Assays User Guide MANO0009593
TaqMan® Drug Metabolism Assays for Triallelic SNPs 135AP01-01
Application Note
AlleleTyper” Software User Guide 4486002
Copy Number Analysis for Pharmacogenomics MANO0014350
Experiments
RNase P Quantification for Genotyping Experiments MANO0O014349
Creating Standard Curves with Genomic DNA or Plasmid 4371090
DNA Templates for Use in Quantitative PCR Application
Note
TagMan® Copy Number Assays Protocol 4397425
CYPZDé Allele-specific Copy Number Analysis Quick MANOQO011114
Reference
Copy Number Analysis for Pharmacogenomics MANO0014350
Experiments
CopyCaller” Software v2.0 User Guide 4400042
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Documentation and support
Customer and technical support

Document Pub. No.
Applied Biosystems™ QuantStudio” 12K Flex Real-Time 4470935
PCR System OpenArray”" Experiments User Guide
OpenArray” technology on the QuantStudio” 12K Flex C023802
System Product Bulletin
QuantStudio™ 12K Flex Real-Time PCR System 4470689
Maintenance and Administration Guide
QuantStudio™ 12K Flex Real-Time PCR System: 4478673
OpenArray” Plate Quick Reference
QuantStudio” 12K Flex Software Help —

Customer and technical support

Visit thermofisher.com/support for the latest in services and support, including:

* Worldwide contact telephone numbers

* Product support, including:
— Product FAQs

— Software, patches, and updates

— Training for many applications and instruments

¢ Order and web support

¢ Product documentation, including:
— User guides, manuals, and protocols

— Certificates of Analysis

— Safety Data Sheets (SDSs; also known as MSDSs)

Note: For SDSs for reagents and chemicals from other manufacturers,

contact the manufacturer.

Limited product warranty

Life Technologies Corporation and/or its affiliate(s) warrant their products as set forth
in the Life Technologies' General Terms and Conditions of Sale found on Life
Technologies' website at www.thermofisher.com/us/en/home/global/
terms-and-conditions.html. If you have any questions, please contact Life

Technologies at www.thermofisher.com/support.
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